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STELLARIUM 

 

Pengamatan luar angkasa merupakan salah satu hal yang banyak menarik keingintahuan manusia. 

Melalui pengamatan langit kita bisa menyaksikan keindahan alam semesta, menyaksikan objek yang 

spektakuler, serta berusaha memahami keberadaan manusia sebagai bagian dari alam semesta ini. 

Pengamatan luar angkasa yang paling sederhana adalah mengamati langit terutama ketika malam tiba. 

Hal tersebut berkembang dengan pemakaian alat bantu yaitu teleskop. Namun seiring dengan 

kesibukan dan kondisi alam yang berubah (langit tertutup gedung atau adanya polusi cahaya) 

menyebabkan kegiatan pengamatan secara langsung tidak dapat dilakukan. 

Stellarium merupakan aplikasi opensource yang berfungsi untuk mensimulasi penampakan segala 

macam benda langit di luar angkasa, seperti: bintang, planet, satelit, galaksi, dan lain-lain. Barangkali 

(CMIIW) nama Stellarium diturunkan dari kata stella yaitu bintang dan rium yaitu tempat, sehingga 

secara harfiah berarti suatu tempat yang berisi jagad ruang angkasa yang dihuni bintang-bintang, 

seperti halnya aquarium sebagai tempat air yang terdapat berbagai objek yang menghuninya. Dengan 

menggunakan stellarium anda seolah-olah memiliki sebuah teleskop, atau bahkan sebuah 

observatorium sendiri. 

 
Pada tulisan ini, kita akan mengenal terlebih dahulu mengenai instalasi, tampilan, dan fitur pada 

aplikasi Stellarium. 

1. Instalasi dan membuka aplikasi Stellarium 

Sebelum menggunakan Stellarium, tentunya anda harus memastikan apakah aplikasi tersebut telah 

terpasang/terinstall di komputer anda. Anda bisa melakukan instalasi lewat paketmanager (Synaptic) 

atau melalui terminal dengan mengetik 

sudo apt-get install stellarium 

Di Linux, aplikasi Stellarium dapat ditemukan pada menu Applications → Science → Stellarium. 



 

2. Pengenalan tampilan (interface) dan alat-alat (tools) pada Stellarium 

Setelah terinstall, anda buka aplikasi Stellarium. Beberapa saat kemudian akan muncul tampilan 

utama Stellarium berupa penampakan langit sesuai tanggal dan waktu yang berjalan di komputer 

anda. 

 

Tampilan awal Stellarium juga dilengkapi dengan 2 menu pop up yang terletak pada bagian pojok 

kiri bawah. Bagian kiri untuk menu jendela tambahan, sedangkan bagian bawah berisi peralatan 

untuk pengamatan (toolbar). 

Pada menu pop up jendela tambahan terdapat 6 pilihan. Secara umum jendela tambahan dapat kita 

aktifkan dengan mengklik ikon pada menu pop up bagian kiri atau dengan menekan tombol hotkey 

masing-masing, sebaliknya kita bisa menonaktifkannya dengan mengklik ikonnya sekali lagi atau 

dengan menekan tanda silang pada bagian pojok kanan atas jendela tersebut. Adapun jendela 

tambahan yang nantinya akan banyak kita gunakan antara lain: jendela lokasi (Location window), 

jendela waktu (Date/time window), jendela langit dan pilihan pandang (Sky and viewing option 

window), serta jendela pencarian (Search window). Sedangkan 2 jendela lainnya, yaitu jendela 

konfigurasi (Configuration window) dan jendela bantuan (Help window) nantinya jarang kita 

gunakan, namun anda masih bisa menggunakan untuk menambah pengetahuan mengenai Stellarium. 

Kita akan sedikit mengupas berbagai fungsi dari jendela tambahan tersebut. 

1. Jendela lokasi (Location window) 

Jendela lokasi berfungsi menentukan lokasi dalam melakukan kegiatan pemantauan (observasi) 

angkasa. Kita bisa menampilkan jendela ini dengan menekan ikon bergambar arah mata angin di 

menu pop up atau dengan menekan tombol “F6”. Lokasi pemantauan hendaknya kita sesuaikan 



dengan tempat tinggal atau tempat beraktifitas. Anda bisa mengatur lokasi pemantauan dengan 

menggunakan 3 metode yaitu: 

 mengklik pada peta dunia  

 mencari nama kota pada kolom pencarian di samping gambar lup atau menggunakan daftar 

nama kota yang tersedia,  

 bila nama kota anda belum terdaftar, maka kita bisa menggunakan setting lokasi secara manual 

dengan mengisikan data Latitude (garis lintang), Longitude (garis bujur), dan Altitude 

(ketinggian dari permukaan laut).  

 

2. Jendela waktu (Date/time window) 

Jendela waktu berfungsi menampilkan waktu dan tanggal kegiatan pemantauan. Default nilai waktu 

disesuaikan dengan waktu yang tertera pada komputer anda. Selain dengan menekan ikon bergambar 

jam pada menu pop up untuk menampilkan jendela ini, bisa juga dengan menekan tombol “F5”. Kita 

bisa melakukan pengubahan waktu dengan mengklik tanda panah atas untuk penambahan, panah 

bawah untuk pengurangan, atau langsung mengetikkannya pada nilai waktu yang ingin diubah. 

 

3. Jendela langit dan pilihan pandang (Sky and viewing option window) 

Jendela langit dan pilihan pandang (View) berfungsi mengatur tampilan pandangan angkasa dan 

lanskap. Tekan ikon bergambar kolom callouts pada menu pop up atau tekan “F4” untuk 

menampakkan jendela ini. Terdapat 4 menu utama dalam bentuk tab, yang terdapat pada bagian atas 

tampilan jendela. Empat menu utama tersebut antara lain: 

 Sky 

Berisi pengaturan tentang tampilan atau pandangan kita terhadap langit dan benda benda 

angkasa. Terdapat 5 kolom pengaturan yaitu: Stars (untuk pengaturan bintang), Planets and 

satellites (untuk pengaturan planet dan satelit, termasuk bulan). Atmosphere (untuk 

pengaturan atmosfer di tempat pemantauan), Labels and Markers (untuk penandaan benda 

langit), dan Shooting Stars ( untuk tampilan bintang jatuh yang nampak pada saat observasi).  



 

 Markings 

Menu markings berfungsi untuk menmberikan bantuan penanda pada bidang pandang di 

angkasa. Terdapat 3 kolom pengatuaran pada menu markings yaitu: Celestial Sphere (untuk 

penandaan ruang angkasa), Constellations (untuk penandaan konstelalasi atau rasi bintang), 

dan Projection (pengaturan proyeksi “cara pandang” kita terhadap angkasa).  

 

 Landscape 

Menu landscape berfungsi mengubah lanskap atau bentuk muka bumi dari lokasi observasi. 

Pada menu ini terdapat beberapa daftar pilihan lanskap serta kolom keterangan dan opsi 

tambahan dari menu lanksape. Kita juga bisa menambah atau mengurangi pilihan lanskape 

dengan tombol “Add/remove landscapes…” yang terletak pada bagian bawah jendela 

landscape.  



 

 Starlore 

Menu starlore hanya berfungsi memilih kebudayaan dalam perbintangan. Pilihan ini tidak 

memiliki fungsi yang urgen, hanya sebagai hiasan (art) serta penamaan suatu rasi bintang 

bintang berdasarkan kebudayaan masyarakat tertentu. Terdapat kolom opsi untuk pengaturan 

default pilihan starlore yang akan digunakan.  

 

4. Jendela pencarian (Search window) 

Berisi kolom pencarian terhadap suatu objek atau posisi astronomis tertentu. Terdapat 3 tabulasi menu 

dalam jendela ini yaitu: Object (untuk pencarian menggunakan nama objek dalam bahasa 

internasional), Position (untuk pencarian dalam koordinat astronomis), dan Options (sebagai opsi 

tambahan dalam pencarian dihubungkan dengan database secara online). Klik ikon bergambar lup 

pada menu pop up atau tekan “F3” untuk menampilkan jendela pencarian. 



 

5. Jendela konfigurasi (Configuration window) 

Jendela ini berisi pengaturan aplikasi Stellarium. Klik ikon bergambar kunci pas pada menu pop up 

atau tekan “F2” untuk menampilkan jendela pencarian. Terdapat 5 menu utama pada jendela ini, 

yaitu: 

 Main 

Menu ini berfungsi mengatur: pilihan bahasa, penampakan informasi suatu benda langit, dan 

pengaturan default aplikasi.  

 Navigation 

Menu ini berisi pengaturan navigasi dalam kegiatan observasi baik menggunakan papantik 

maupun tetikus.  

 Tools 

Menu ini berisi serangkaian alat untuk pengaturan planetarium, lokasi dan opsi penyimpanan 

file hasil screenshot, serta pembaruan katalog bintang.  

 Scripts 

Menu ini berisi serangkaian skrip-skrip yang menarik. Saya sarankan anda mencoba beberapa 

skrip yang tersedia dengan memilihnya, lalu menekan tombol “play”(tanda panah ke kanan) 

di bagian bawah jendela :D.  

 Plugins 

Menu ini berisi daftar, keterangan, serta pengaturan plugin dari aplikasi stellarium. Kita bisa 

melakukan pengaturan dengan mengklik tombol “configure” pada kolom Options di setiap 

plugins.  

 



6. Jendela bantuan (Help window) 

Jendela bantuan berisi 3 menu utama yang menunjukkan informasi seputar aplikasi Stellarium. 

 Menu Help berisi daftar shortcut atau hot key serta daftar link web untuk mencari informasi 

seputar Stellarium.  

 Menu About berisi informasi lisensi, serta daftar pengembang (developers) yang memberikan 

sumbangsihnya terhadap perkembangan aplikasi Stellarium.  

 Menu Log berisi daftar pesan dari terminal, ketika kita menjalankan aplikasi Stellarium, yang 

disimpan pada file log.txt di direktori ~/.stellarium. Kita bisa menampilkan jendela bantuan 

dengan mengklik pada ikon bergambar tanda tanya pada menu pop up atau dengan menekan 

tombol “F1”.  

 

Pada bagian bawah tampilan Stellarium terdapat menu pop up yang berisi peralatan untuk mengatur 

kegiatan pengamatan kita, oleh karenanya menu pop up ini bisa disebut juga dengan toolbar. Pada 

bagian atas menu pop up toolbar juga terdapat keterangan indikator pengamatan seperti lokasi, waktu, 

dan indikator lainnya. Secara garis besar tombol pada toolbar dibagi menjadi 3 kelompok yaitu 

tombol untuk keperluan pengamatan, tombol untuk keperluan pengaturan waktu, dan tombol keluar. 

Berikut adalah penjelasan singkat beserta hotkeynya (dari kiri ke kanan): 

 

Tombol untuk keperluan pengamatan terdiri atas 16 tombol. 

3 tombol yang mengatur penampakan konstelasi atau rasi bintang: Constellation lines (tombol 

hotkey [C]), Constellation labels (tombol hotkey [V]), dan Constellation art (tombol hotkey [R]). 

2 tombol yang mengatur penampakan garis bantu: Equatorial grid (tombol hotkey [E]) dan 

Azimuthal grid (tombol hotkey [Z]). 

2 tombol mengatur penampakan lokasi observasi: Ground (tombol hotkey [G]), Cardinal points 

(tombol hotkey [Q]), dan Atmosphere (tombol hotkey [A]). 

2 tombol mengatur pelabelan benda langit: Nebulas (tombol hotkey [N]) dan Planet labels (tombol 

hotkey [P]). 

4 tombol mengatur cara pandang: Switch between equatorial and azimuthal mount (tombol hotkey 



[Ctrl+M]), Center on selected object (tombol hotkey [Spasi]), Night mode (tidak punya hotkey), 

dan Full screen (tombol hotkey [F11]). 

2 tombol tambahan untuk pengamatan: Ocular view (tombol hotkey [Ctrl+O]) dan Satellite hints 

(tombol hotkey [Ctrl+Z]) 

Hint: selain tombol diatas, untuk membantu pengamatan (memperbesar tampilan objek) kita bisa 

menggunakan tombol scroll pada tetikus. Scroll keatas untuk memperdekat atau memperbesar 

tampilan objek, dan sebaliknya scroll ke bawah untuk memperjauh atau memperkecil tampilan. Anda 

juga bisa langsung memperjelas objek dengan menekan tombol slash (/). 

Tombol pengaturan waktu terdiri atas 4 tombol 

Kita bisa mengatur jalannya waktu pengamatan dengan menggunakan 4 tombol pengaturan waktu 

yaitu: Decrease time speed (tombol hotkey [J]), Set normal time rate (tombol hotkey [K]), Set 

time to now (tombol hotkey [8]), dan Increase time speed (tombol hotkey [L]) 

Tombol keluar terdiri atas 1 tombol dengan hot key Ctrl+Q. 

Selain toolbar, pada jendela pengamatan terdapat 2 indikator. Indikator pertama (indikator seting 

pengamatan) terletak di bagian bawah (menempel pada toolbar), yang di dalamnya terdapat 

keterangan mengenai lokasi serta waktu pengamatan. Indikator kedua terletak di bagian kiri atas 

jendela pengamatan ketika kita telah mengamati (mengklik) suatu objek angkasa. Pada indikator 

kedua ini (indikator objek) terdapat beberapa informasi, diantaranya: nama objek, magnitudo 

(kecemerlangan), magnitudo absolut, derajat pengamatan, azimut dan altitud, dan lain sebagainya. 

 

Demikian paparan singkat dari antarmuka dan tampilan Stellarium. Penjelasan tentang kegiatan 

pengamatan dan cara menggunakan toolbar, insya Alloh akan kita sambung pada tulisan-tulisan 

berikutnya 

  



Pengamatan Bulan dengan Stellarium 

 

Pada panduan kali ini, kita akan mulai mengaplikasikan penggunaan Stellarium dalam kegiatan 

pengamatan luar angkasa. Sebelumnya saya ingin mengajukan beberapa pertanyaan kepada anda, 

Apakah anda juga seorang penggemar olahraga mancing?, atau anda orang yang bermukim dan 

beraktivitas di daerah pesisir?, tentunya mengetahui kondisi pasang surut air laut adalah penting bagi 

anda yang memiliki kondisi tersebut. Pasang surut air sangat mempengaruhi waktu dan tempat 

memancing, mempengaruhi kapan dan bagaimana kita melakukan aktivitas di daerah pesisir, serta 

kapan para pemukim di pesisir harus bersiap untuk bencana rob dan ombak pasang, dan lain 

sebagainya. Pasang surut air laut diperngaruhi oleh banyak hal, salah satu yang paling utama adalah 

peredaran bulan. Bagi anda yang mancing mania, mengetahui kapan bulan bersinar juga akan 

menentukan hasil perolehan ikan anda. Para mancing mania mau tidak mau harus menentukan 

iluminasi (penerangan) serta fase bulan, terutama mereka yang hendak memancing di laut. 

Nah, dari berbagai kondisi di atas akan muncul pertanyaan, Bagaimana memperkirakan kondisi 

peredaran dan fase bulan? Bisakah kita yang bukan seorang astronom alias yang hanya sebagai orang 

awam mampu memperkirakan kondisi peredaran bulan? Jangan khawatir, anda bisa melakukan itu 

semua bak seorang ahli astronomi dengan sebuah menggunakan software opensource yang bernama 

Stellarium 

Sekarang adalah saatnya kita untuk beraksi, hehe. Maksudnya kita akan mencoba melakukan simulasi 

peredaran Bulan dengan Stellarium. Sebelumnya terdapat penjelasan ilustrasi tentang keadaan 

seorang pemancing sebagai berikut. Seorang mancing mania “tajir”, berencana mengadakan rekreasi 

memancing sekaligus “pulkam” pada akhir tahun 2014, dikarenakan akhir tahun merupakan masa 

liburan kuliah anaknya serta jadwal kerja yang memang mulai longgar. Pemancing tersebut telah 

menjadwalkan liburan antara tanggal 22 Desember 2014 – 4 Januari 2015, namun ia juga berencana 

mengajak kolega dan kawan lamanya sehingga kegiatan memancing diperkirakan akan terjadi pada 

sekitaran hari libur nasional atau hari Sabtu-Minggu. Oleh karena itu kita akan berkutat dengan 

pengamatan Bulan pada masa tersebut. Tempat kegiatan memancing akan dilakukan di kota 

kelahirannya yaitu Rembang yang merupakan kota di pesisir pantura, Jawa, Indonesia. Adapun jenis 

kegiatan memancing dan lokasinya adalah memancing di pantai karang dan memancing tonda 

(trolling) di tengah laut, yang kesemuanya dilakukan pada malam hari karena target “buruan”nya 

adalah ikan-ikan besar. 

1. Mengamati kondisi bulan dengan Stellarium 

1. Langkah pertama kita adalah membuka aplikasi Stellarium. Di BlankOn, aplikasi Stellarium dapat 

dibuka dengan mengklik pada menu Applications → Science → Stellarium. 

 

2. Setelah muncul tampilan awal segera lakukan setting lokasi pengamatan. Pada ilustrasi di atas kita 

akan menggunakan kota “Rembang” sebagai kata kuncinya. Segera klik ikon bergambar mata angin 

pada menu pop up di bagian kiri, atau tekan “F6”. Lalu muncullah jendela pencarian dan ketikkan 

“Rembang” pada kolom pencarian di sebelah gambar lup. Setelah muncul kota Rembang dalam 

daftar kota, maka pilihlah dengan mengklik pada kota tersebut. 

 

3. Langkah berikutnya kita sesuaikan berberapa hal dalam jendela pandang. Klik ikon bergambar 

kolom callouts pada menu pop up atau tekan “F4”. Pada tab “Sky” lakukan penyesuaian dengan 



memberi tanda centang pada opsi “Scale moon” di kolom “Planetes and satellites”, ini berfungsi 

untuk memperbesar tampilan Bulan menjadi 4 kali saat pengamatan nanti. 

 

Kemudian lanjut pada tab “Markings”, lakukan pengubahan “cara pandang” dengan mengganti 

pilihan di kolom “Projection” yang semula “Stereographic” menjadi “Perspective”, hal ini untuk 

mempermudah default pengamatan kita sekaligus membantu dalam penyesuaian indikator ketinggian 

Bulan nantinya. 

 

Pindah pada tab “Landscape”, ubahlah pilihan lanskape kita dari “Guereins” menjadi “Ocean”. 

Pengubahan ini akan mengubah tampilan lanskap dari padang rumput menjadi lautan, menyesuaikan 

dengan tema kita yaitu memancing di laut :D. 

 

4. Selanjutnya kita akan melakukan seting waktu pengamatan. Tekan ikon bergambar jam pada menu 

pop up untuk menampilkan jendela waktu, bisa juga dengan menekan tombol “F5”. Sesuai ilustrasi 

di atas, kita akan mengubah kolom tanggalnya menjadi “2014 / 12 / 22” dengan mengklik tombol 

pengaturan (tombol panah) atau dengan mengetikkannya pada tempat tahun/bulan/tanggal. Lalu pada 

kolom waktu dengan format jam:menit:detik kita ubah nilainya menjadi “20 : 0 : 0”. 

 

Tambahan: saat mengubah waktu, mungkin indikator detik kita akan bergerak, untuk itu kita perlu 

menghentikan waktu pengamatan dengan mengklik tombol “Set normal time rate” pada pop up 

toolbar atau tekan tombol [K], sehingga waktu pengamatan akan berhenti. Anda bisa melihat 

perubahan tanda “play” menjadi “pause”. 

 

5. Nah, menginjak langkah selanjutnya adalah mencari Bulan.  

Klik ikon bergambar lup pada menu pop up atau tekan “F3” untuk menampilkan jendela pencarian. 

Setelah itu kita ketikkan kata kunci “moon” (tanpa tanda kutip), kemudian tekan enter maka kita 

akan langsung dibawa kepada Bulan. Dan apa yang terjadi ……., ternyata Bulan tidak nampak, lho 

kok bisa? 

 

Bulan tidak nampak karena pada saat itu posisinya membelakangi kita di balik bumi, sehingga setelah 

kita malah dibawa melihat lautan. Anda masih tidak percaya? Sekarang kita coba menggunakan 

toolbar mengklik ikon “Ground” pada menu toolbar atau tekan tombol [G]. Nah, tampaklah Bulan 

yang menjadi “target” dengan tanda 4 strip merah. Sambil kita lihat pada bagian kiri atas terdapat 

sejumlah indikator keadaan Bulan. Pada indikator “Phase” tampak nilai 0.00 yang diartikan sebagai 

Bulan dalam keadaan “bulan baru”. Nilai “Phase” berkisar antara 0.00 hingga 1.00, sehingga bila 



keterangan sebelumnya kita lanjutkan maka semakin besar nilainya akan menujukkan tiap fase Bulan 

yang tumbuh fase dari “bulan baru” menjadi “bulan sabit” menjadi “bulan separuh” hingga “bulan 

purnama”, lalu setelah pertengahan bulan maka fase Bulan kembali lagi menuju fase “bulan baru”. 

 

Jika kita amatilah maka citra Bulan dalam tanda target yang berupa bulatan gelap. Selain karena nilai 

“Phase” = 0.00, kita bisa mengamati nilai “Illuminated” yang bernilai 0,4%. Hal tersebut menandakan 

bahwa Bulan “menampakkan” cahayanya atau tersinari matahari hanya sebesar 0,4%. Nilai tersebut 

akan bertambah seiring bertambahnya nilai “Phase” bulan yang nanti saat bulan purnama akan 

mencapai nilai 0.96-1.00. 

Kita juga bisa memastikan posisi bulan yang tenggelam atau membelakangi kita dengan mengklik 

ikon “Azimuthal grid” atau dengan menekan tombol [Z]. Setelah itu akan tampak garis bantu berupa 

garis Azimuth (garis yang membujur) dan garis Altitude (garis yang melintang). Secara kasar, dengan 

bantuan garis Altitude kita mengetahui posisi bulan antara -20º hingga -30º. Posisi yang tepat dari 

Altitude Bulan bisa kita lihat di indikator keadaan Bulan, yaitu pada indikator “Az/Alt” yang bernilai 

-26º 42’31”. Posisi Altitude Bulan yang bernilai minus (-) menunjukkan posisi bulan yang berada 

tenggelam di bawah cakrawala. 

 

Hasil pengamatan sesuai dengan seting tempat dan waktu yang telah kita lakukan, menunjukkan 

posisi bulan yang tenggelam membelakangi bumi. Maka diperkirakan lautan akan terjadi surut, 

dikarenakan air laut ditarik ke belakang oleh gravitasi Bulan. Selain Bulan, nampak juga label dan 

objek benda langit yang lain dalam sistem tata surya kita, yaitu Matahari dan planet lain (Venus dan 

Merkurius), sehingga diperkirakan akan terjadi surut yang cukup besar dikarenakan tarikan gravitasi 



benda-benda langit tersebut. 

 

6. Setelah mengetahui keadaan Bulan pada pukul 20:00, kita akan mencoba melihat keadaan dan 

posisi bulan tiap jamnya hingga pukul 04:00. 

Tekan ikon bergambar jam pada menu pop up atau menekan tombol “F5” untuk menampilkan jendela 

waktu. Lalu tarik jendela tersebut ke bagian kanan bawah.  

Tekan tanda panah atas kolom jam (di atas angka 20), maka setiap kali kita tekan akan bertambah 1 

jam kemudian. 

Ulangi tekan tanda panah atas kolom jam hingga bertambah secara berurutan dari 20, 21, 22, 23, 0, 

1, 2, 3, 4, sambil kita amat indikator dan posisi Bulan setiap kali kita tambahkan.  

Dari pengamatan secara berurutan, akan tampak posisi Altitude Bulan paling tinggi pada pukul 00:00 

di hari berikutnya, dengan nilai -65°27’53”, sehingga diperkirakan surut terrendah akan terjadi pada 

kisaran waktu ini. Nilai “Phase” dan “Illuminated” juga bertambah sedikit karena pada hari itu bulan 

baru menginjak fase bulan baru. 

 

Dari indikator kesurutan (altitude bulan) dan minimnya sinar bulan (fase dan pencahayaan) maka 

diperkirakan kegiatan memancing di pantai karang sangat cocok sebagai pilihan.  

Hint: Pada umumnya memancing karang dilakukan di daerah pesisir yang sangat terpengaruh 

dengan pasang surut air laut. Apabila air surut maka gelombang laut tidak akan seberapa berbahaya 

seperti gelombang saat air pasang. Terkadang memancing di karang dilakukan sambil berendam 

dengan sedikit ke tengah berada di pucuk terumbu yang masih cukup dangkal, namun di depannya 

terdapat tubiran hingga jurang laut yang cukup dalam, oleh karena itu memacing di saat surut dan 

gelaombang kecil lebih aman untuk dilakukan apalagi saat malam. Selanjutnya kondisi fase dan 

pencahayaan Bulan yang minim akan menguntungkan karena ikan-ikan akan keluar dari tempat 

persembunyiannya. Para pakar memancing menduga bahwa ikan-ikan di daerah karang tidak suka 

dengan kondisi sinar Bulan yang terang, dan ikan cenderung tersembunyi dalam karang. Beberapa 

pemancing bahkan mengatakan bahwa ikan-ikan karang dapat mendeteksi sinar dari bara rokok 

yang menyala, luar biasa bukan? :D. 

 

7. Setelah mendapat “hari baik” untuk memancing di pantai karang, kita akan mencoba untuk mencari 

hari memancing tonda (trolling). Memancing tonda dilakukan di tengah laut dengan menggunakan 

kapal yang dijalankan. Menurut pengalaman para mancing mania, waktu yang paling baik untuk 

memancing tonda adalah saat malam bulan purnama.  

Masih dengan setting lokasi yang sama dan waktu yang sama, kita tekan ikon bergambar jam pada 

menu pop up atau menekan tombol “F5” untuk menampilkan jendela waktu. Lalu tarik jendela 

tersebut ke bagian kanan bawah dan kita klik kembali ikon “Ground” atau tekan tombol [G] sehingga 

ground yang tadinya hilang muncul kembali. 

Kita ubah tanggal pengamatan dengan menekan tanda panah di atas kolom tanggal (di atas angka 22). 

Setiap kali kita tekan akan bertambah 1 hari kemudian 

Ulangi tekan tanda panah atas kolom tanggal hingga bertambah secara berurutan dari 22, 23, 24, 25, 

26, 27, 28, 29, 30, 31, 1, 2, 3, 4, sambil kita amati indikator posisi, dan keadaan Bulan setiap kali kita 

tambahkan. Untuk melihat Bulan secara dekat kita bisa menggunakan scroll pada tetikus, scroll ke 

atas untuk memperbesar dan scroll ke bawah untuk memperkecil. 

 



Selain dengan scroll, kita juga dapat memanfaatkan tool okular, dengan mengklik ikon “Ocular view” 

pada menu pop up toolbar atau tekan tombol [Ctrl+O]. untuk menon aktifkan mode okular bisa 

dengann mengklik kembali ikon okular atau tombol hotkeynya 

 

Dari pengamatan secara berurutan, dapat terlihat bahwa pada tanggal 3 Januari 2014 pukul 20:00 

penampakan Bulan sudah purnama dengan nilai “Phase”: 0.97 (> 0.95). 

 

Selanjutnya pada tanggal yang sama kita ubah waktu pengamatan, dengan menekan tanda panah atas 

kolom jam secara berurutan dari pukul 20:00 hingga 04:00 hari berikutnya. Nilai Altitude bulan 

mencapai puncaknya pada kisaran pukul 22:00, dengan nilai 63°. Nilai “Phase” dan “Illuminated” 

juga bertambah mengikuti fase bulan purnama. Kita juga bisa melihat pergerakan Bulan pada hari itu 

dengan memakai tool pengaturan waktu pada menu pop up toolbar. Kita klik ikon “Set normal time 

rate” atau tekan tombol [K], sehingga terjadi pergerakan (peredaran) Bulan. Selanjutnya klik ikon 

“Increase time speed” atau tekan tombol [L] beberapa untuk mempercepat pergerakan dan klik ikon 

“Decrease time speed” atau tekan tombol [J] untuk memperlambat. Dengan menekan masing-

masing ikon secara berulang dapat memberi efek peningkatan dan penurunan dari kecepatan 

pengamatan. 

 

Dikarenakan posisi Bulan yang tampak di hadapan kita, maka kemungkinan akan terjadi pasang air 

laut. Namun kenaikannya tidak besar, karena di samping Bulan tidak ada Matahari maupun planet-

planet dalam tata surya kita. Melihat keadaan yang demikian maka diperkirakan pada malam hari 

tanggal 3 Januari 2015 akan cocok untuk melakukan kegiatan memancing tonda (trolling). 

Hint: memancing tonda (trolling) memang baik dilakukan saat bulan purnama karena saat sinar 

bulan sedang terang akan memicu plankton untuk naik ke permukaan laut, sehingga akan menarik 

ikan kecil, udang, dan cumi untuk makan, yang kemudian akan mengundang ikan-ikan besar pelagis 

yang berperan sebagai predator. Berbeda dengan ikan-ikan karang, ikan pelagis tidak terlalu takut 

dengan cahaya bulan, karena mereka lebih mementingkan untuk mencari makan pada saat mangsa 

mereka sedang keluar. Ketika berada di tengah laut apabila kita tidak bisa memancing tonda, kita 



bisa menggunakan metode alternatif seperti: jigging, memancing dasar, atau casting dengan umpan 

yang berpendar (fosfor). 

Demikian penjelasan cara mengamati Bulan dengan Stellarium, semoga anda tidak “mumet” :D. 

Sebelum saya tutup, saya ingin menyampaikan beberapa hal.  

1. Disclaimer: bahwa perkiraan kondisi di atas belum mencakup kondisi cuaca dan keadaan 

gelombang laut, sehingga kemungkinan keadaan pasang-surut di lapangan bisa sangat berbeda. Dan 

dalam hal hasil memancing sendiri dipengaruhi oleh berbagai macam faktor, termasuk faktor 

keberuntungan, jadi tetap semangat untuk para mancing mania :D. 

2. Pengamatan bulan ini dapat juga diaplikasikan untuk kegiatan lainnya. Jadi tetap kreatif dan positif 

untuk memanfaatkannya. 

  



PENGAMATAN TATA SURYA 

 

Sistem tatasurya adalah sebuah kelompok yang terdiri atas beberapa planet dengan satu atau lebih 

bintang. Seperti yang telah kita ketahui, sistem tatasurya kita terdiri atau sebuah bintang yaitu 

matahari dengan beberapa planet salah satunya adalah planet yang kita huni yaitu Bumi. Mengamati 

sistem tata surya adalah sarana pembelajaran yang baik dalam meningkatkan pengetahuan mengenai 

alam dan isinya (sains), sekaligus memahami kebesaran Sang Maha Pencipta dan betapa “kerdil”nya 

kita sebagai umat manusia (imtak). Langsung saja kita akan mengamati anggota sistem tata surya kita 

menggunakan Stellarium. Buka menu Applications -> Science -> Stellarium. 

Matahari 

Matahari adalah bintang dalam tatasurya kita dan merupakan objek yang mudah terlihat oleh kita, 

akan tetapi mengamati matahari dengan mata telanjang pada siang hari dapat berbahaya bagi mata 

kita. Para ilmuwan menggunakan perangkat khusus (salah satunya dengan proyeksi layar atau film 

foto) dalam mengamati matahari. Dengan Stellarium kita juga bisa “mengamati” matahari dengan 

aman dan mudah. 

Mula-mula kita buka jendela waktu dengan mengklik ikon Date/time window di sisi kiri atau dengan 

menekan tombol F5. Setelah itu kita atur waktu pengamatan yaitu pukul 10:00. 

Selanjutnya buka jendela pencarian dengan mengklik ikon Search window di sisi kiri atau menekan 

tombol F3. Ketikkan kata kunci “sun” lalu tekan tombol enter, maka kita akan dibawa melihat 

matahari yang silau hehe. 

Untuk mengubah tampilannya menjadi lebih sejuk, kita dapat menghilangkan efek atmosfer dengan 

mengklik tombol Atmosphere pada toolbar di bagian bawah atau dengan menekan tombol A. 

 
Hint: Apabila kita melihat ke pojok kanan atas bidang pandang terdapat beberapa indikator berkenaan 

dengan objek yang kita amati. Salah satu indikator tersebut adalah Distance atau jarak. Jarak dari 

Bumi ke Matahari digunakan sebagai salah satu satuan jarak dalam kegiatan Astronomi. Pada 

indikator Distance tertera ~ 1 AU (Astronomical Unit) yang setara dengan 149,6 juta km. 

Selanjutnya kita akan melihat matahari lebih dekat. Klik ikon Ocular view pada toolbar atau tekan 

tombol Ctrl+O. Matahari akan terlihat lebih dekat, nampak permukaan matahari dengan “bintik 

hitam” yang teramati, dan sering disebut sebagai bintik Matahari. 



 
Hint: Bintik Matahari adalah suatu area yang bersuhu lebih rendah (~1500 derajat) dari area yang 

lain. Bintik ini muncul dan menghilang akibat perubahan pada medan magnet Matahari. Bintik 

Matahari diperkirakan memiliki pola dalam siklus 11 tahunan. 

Merkurius 

Ok, kita beralih pada pengamatan planet-planet yang mengorbit kepada Matahari. Planet yang 

terdekat dengan Matahari adalah Merkurius. Kita bisa mencarinya dengan menggunakan jendela 

pencarian (klik pada ikon Search window atau tekan F3) lalu ketik kata kunci “mercury“. Oleh 

karena letaknya yang dekat dengan Matahari, maka kita perlu menonaktifkan fitur Atmosfer, klik ikon 

Atmosphere pada toolbar atau tekan tombol A. 

Untuk mengamati permukaan Merkurius secara lebih dekat, kita tidak bisa menggunakan fitur Ocular 

view, jadi kita perlu melakukan scroll ke atas pada tetikus hingga tampak gambaran permukaannya. 

 
Hint: Merkurius menjadi planet terkecil dari sistem tatasurya kita, setelah tahun 2006 Pluto tidak lagi 

digolongkan sebagai planet utama. Ia berrotasi dengan lambat yaitu 1416 jam/rotasi. Permukaannya 

diselimuti oleh banyak kawah akibat hantaman komet atau asteroid. 

Venus 

Planet ini merupakan planet yang mengorbit dengan urutan kedua dari matahari. Ukurannya yang 

relatif besar (hampir sama dengan Bumi) serta orbitnya yang relatif dekat dengan Matahari, 

membuatnya mudah untuk diamati dengan mata telanjang ketika fajar atau senja. Oleh karena itu, ia 

sering disebut sebagai “Bintang Fajar” atau “Bintang Senja”. 

Untuk membuktikannya mula-mula kita buka jendela waktu (klik ikon Date/time window atau tekan 

F5), lalu kita atur kolom tanggal dan waktunya menjadi 2014/1/1 dan 18:0:0. Selanjutnya kita mencari 

Venus dengan menggunakan jendela pencarian, klik pada ikon Search window atau tekan F3, lalu 

ketik kata kunci “venus“. Kita bisa melihatnya dengan mudah diatas ufuk barat sebelum matahari 

tenggelam. 



 
Berikutnya kita atur kolom tanggal dan waktunya menjadi 2014/5/1 dan 5:0:0. Akan nampak Venus 

berada di atas langit sebelah timur sebelum matahari terbit. 

Untuk mengamati permukaan Venus lebih dekat, kita bisa melakukan scroll keatas pada tetikus. Oleh 

karena letaknya yang dekat dengan Matahari, terkadang kita juga perlu menonaktifkan fitur Atmosfer, 

klik ikon Atmosphere pada toolbar atau tekan tombol A. 

 
Hint: Atmosfer Venus diselimuti oleh gas (paling banyak karbon dioksida) yang sangat tebal, 

menjadikannya memantulkan sebagian besar cahaya Matahari sehingga tampak benderang seperti 

bintang. Ada juga yang menamakannya sebagai Bintang Kejora. Venus memiliki rotasi terlama dalam 

tatasurya, serta arah rotasinya berlawanan dengan arah rotasi Bumi (tampak mundur). 

Bumi 

Bumi merupakan planet indah yang kita huni. Suatu planet yang indah dengan kehidupan di 

dalamnya. Pengamatan Bumi dengan menggunakan Stellarium kurang mungkin dilakukan, akan 

tetapi kita masih bisa melihat beberapa indikator keterangan bumi dengan memasukkan kata kunci 

“earth” dalam kolom pencarian :D. InsyaAlloh kita akan mengamati bumi dengan lebih baik 

menggunakan software yang lain, pada panduan yang lain :). 

Mars 

Mars merupakan planet keempat yang mengelilingi Matahari. Ia sering teramati sebagai benda terang 

yang melintasi langit tiap-tiap malam. Untuk mengamatinya mula-mula pada Stellarium kita buka 

jendela waktu (klik ikon Date/time window atau tekan F5), lalu kita atur kolom tanggal dan 

waktunya menjadi 2014/7/15 dan 21:0:0. Selanjutnya kita mencari Mars dengan menggunakan 

jendela pencarian, klik pada ikon Search window atau tekan F3, lalu ketik kata kunci “mars“. Anda 

juga bisa mengatur kolom tanggal dan waktu sesuai dengan keinginan anda asakan kita bisa melihat 

Mars sebagai titik terang di langit malam :D. 

Untuk mengamati permukaan Mars lebih dekat, kita bisa melakukan scroll keatas pada tetikus. Dari 

pengamatan secara dekat akan nampak permukaan merah dari planet Mars. 



 
Hint: Permukaan Mars berwarna merah karena permukaan tanahnya yang banyak mengandung besi 

oksida. Mars juga memiliki kutub yang diselimuti es. Mars merupakan planet terakhir dalam 

golongan planet terestrial (planet yang memiliki permukaan tanah dan batuan), bersama Merkurius, 

Venus, dan Bumi. Keempat planet tersebut juga sering dinamakan golongan planet dalam (inner 

planet). 

Jupiter 

Jupiter merupakan planet terbesar dalam sistem tatasurya kita dan meupakan planet dengan urutan 

kelima. Kita buka jendela waktu (klik ikon Date/time window atau tekan F5), lalu kita atur kolom 

tanggal dan waktunya menjadi 2014/4/1 dan 21:0:0. Selanjutnya kita mencari Jupiter dengan 

menggunakan jendela pencarian, klik pada ikon Search window atau tekan F3, lalu ketik kata kunci 

“jupiter“. Anda juga bisa mengatur kolom tanggal dan waktu sesuai dengan keinginan anda asalkan 

kita bisa melihat Jupiter. Ada kalanya kita kehilangan label Planet, kita bisa mengaktifkannya kembali 

dengan mengklik ikon Planets label pada toolbar. 

 
Hint: Jupiter merupakan planet terbesar dengan permukaan beraneka lapisan warna. Permukaan yang 

demikian disebabkan oleh atmosfernya yang berawan yang berbeda beda susunan kimiawinya. Para 

ahli bahkan berpendapat bahwa planet ini tidak memiliki permukaan (kerak) yang padat, dibawah 

atmosfernya yang berawan terdapat susunan hidrogen cair yang panas, logam cair, dan inti yang 

berbatu. Ia juga memiliki banyak bulan yang mengorbit padanya. 

Saturnus 

Saturnus merupakan planet terbesar kedua dalam sistem tata surya kita, dengan urutan orbit keenam 

dari Matahari. Mula-mula kita buka jendela waktu (klik ikon Date/time window atau tekan F5), lalu 

kita atur kolom tanggal dan waktunya menjadi 2014/4/1 dan 21:0:0. Selanjutnya kita mencari Mars 

dengan menggunakan jendela pencarian, klik pada ikon Search window atau tekan F3, lalu ketik 

kata kunci “saturn“. Nonaktifkan fitur Atmosfer untuk memperjelas tampilannya. 



 
Hint: Saturnus merupakan planet yang indah karena dikelilingi oleh lapisan cincin-cincin yang 

spektakuler. Penyusun cincin Saturnus adalah es, batu, dan debu. Ia merupakan planet yang paling 

jauh yang dapat diamati tanpa bantuan teleskop (tampak sebagai titik terang di langit). Para ahli 

menduga bahwa planet ini sebagian besarnya tersusun atas gas, sehingga memiliki kerapatan paling 

rendah dari planet-planet yang ada, bahkan menurut para ilmuwan, bila Saturnus dimasukkan ke air 

maka ia akan mengambang :D. 

Uranus 

Uranus merupakan planet ketujuh dari sistem tatasurya kita. Untuk mengamatinya kita buka jendela 

waktu (klik ikon Date/time window atau tekan F5), lalu kita atur kolom tanggal dan waktunya 

menjadi 2014/9/1 dan 21:0:0. Selanjutnya kita mencari Mars dengan menggunakan jendela pencarian, 

klik pada ikon Search window atau tekan F3, lalu ketik kata kunci “uranus“. Nonaktifkan fitur 

Atmosfer dan gunakan scroll keatas pada tetikus, untuk memperjelas dan memperbesar tampilannya. 

 
Hint: Planet Uranus merupakan planet pertama yang ditemukan dengan bantuan teleskop, boleh jadi 

karena jarak Uranus yang ke Matahari yang jauhnya hampir dua kali jarak Saturnus ke Matahari. 

Indikator pengamatan planet Uranus menunjukkan bahwa jaraknya dari bumi (Distance) sebesar 19 

AU, hampir dua kali jarak pengamatan Saturnus yang sebesar 10 AU. Planet ini memiliki cincin yang 

tipis yang tersusun dari partikel debu yang gelap. Atmosfer Uranus berwarna biru tersusun atas 

Hidrogen, Helium dan Metana. 

Neptunus 

Neptunus merupakan planet kedelapan dan merupakan planet terakhir dalam susunan tatasurya kita. 

Untuk mengamati Neptunus, kita buka jendela waktu (klik ikon Date/time window atau tekan F5), 

lalu kita atur kolom tanggal dan waktunya menjadi 2014/9/1 dan 21:0:0. Selanjutnya kita mencari 

Neptunus dengan menggunakan jendela pencarian, klik pada ikon Search window atau tekan F3, lalu 

ketik kata kunci “neptune“. Gunakan scroll ke atas pada tetikus atau tekan tombol / untuk 

memperbesar tampilannya. 



 
Hint: Hampir serupa dengan Saturnus dan Uranus, planet ini tersusun oleh sebagain besar gas. Gas 

Metan yang menyusun atmosfer planet ini menjadikannya berwarna kebiruan. Neptunus juga 

merupakan planet terakhir dari golongan planet Jovian (planet yang sebagian penyusunnya adalah 

gas), bersama Jupiter, Saturnus, dan Uranus. Keempat planet tersebut tergolong dalam planet luar 

(outer planet), yang dipisahkan oleh sabuk asteroid dari golongan planet dalam (inner planet). 

Planet kerdil : Pluto, Eris, Ceres 

Pada tahun 2005 ditemukan sebuah planet baru diluar orbit Pluto, yang kemudian diberi nama Eris. 

Penemuan tersebut memicu perdebatan sengit, sehingga pada tahun 2006 timbul kesepakatan dari 

para astronom dunia bahwa Pluto tidak lagi digolongkan ke dalam jajaran planet utama. Para ilmuwan 

lalu mengelompokkan Pluto kedalam golongan planet kerdil (Dwarf Planets). Selain Pluto, terdapat 

2 planet yang termasuk dalam golongan Planet kecil yaitu Eris dan Ceres. 

Untuk mengamati Pluto, kita buka jendela waktu (klik ikon Date/time window atau tekan F5), lalu 

kita atur kolom tanggal dan waktunya menjadi 2014/9/1 dan 21:0:0. Selanjutnya kita mencari Pluto 

dengan menggunakan jendela pencarian, klik pada ikon Search window atau tekan F3, lalu ketik 

kata kunci “pluto“. Gunakan scroll keatas pada tetikus untuk memperbesar tampilannya. Ulangi 

langkah yang sama untuk pengamatan planet Eris dan Ceres. 

 
Hint: Ceres merupakan planet kerdil yang terletak di sabuk asteroid (antara Mars dan Jupiter), 

beberapa astronom mengelompokkannya ke dalam Asteroid. Pluto dan Eris terletak di sabuk Kupier, 

yaitu wilayah di luar tatasurya yang didiami oleh beragam benda angkasa dari batuan-es, wilayah 

tersebut juga dianggap sebagai sumber komet. Anda bisa membuktikannya dengan melihat pada 

indikator jarak (Distance). 

Terkadang dalam pengamatan kita “kehilangan” penampakan dari suatu planet, oleh karenanya kita 

bisa mengaktifkan label nama planet dengan mengklik ikon Planet labels pada toolbar atau dengan 

menekan tombol P. Kita juga bisa memanfaatkan fitur bantuan pengamatan planet di jendela View 

pada tabulasi Sky, pada bagian Planets and satelllites terdapat fasilitas untuk membantu 

menampakkan label planet, jalur orbit planet, dll. Demikian simulasi “penjelajahan” pada sistem tata 

surya kita. Semoga bermanfaat :D, sampai jumpa pada panduan Stellarium yang lain. 

 

  



Pengamatan Gerhana dengan Stellarium 

 

Gerhana merupakan salah satu fenomena alam yang menarik bagi umat manusia. Matahari atau Bulan 

yang bersinar tiba-tiba tertutup oleh suatu bayangan yang menimbulkan panorama yang menarik dan 

menakjubkan. Peristiwa gerhana diakibatkan oleh kesejajaran antar 3 buah objek, yaitu Matahari, 

Bumi dan Bulan, dalam satu garis. Mengamati gerhana merupakan suatu hal yang terkadang sulit dan 

berbahaya. Sementara itu, tidak setiap daerah selalu dapat melihat fenomena gerhana. 

Pada panduan kali ini kita akan mencoba mengamati simulasi gerhana secara mudah dan aman. 

Seperti biasa dalam pengamatan benda langit, kita akan menggunakan aplikasi Stellarium. Kita juga 

akan menggunakan Stellarium untuk memverifikasi data lokasi dan waktu terjadinya gerhana yang 

kita peroleh dari lembaga astronomi atau internet. 

Gerhana Matahari 

Meskipun Matahari memiliki ukuran yang jauh lebih besar dibandingkan dengan Bulan, Jarak bulan 

yang lebih dekat dengan Bumi menjadikan Bulan terlihat berukuran sama. Jika Matahari, Bulan, dan 

Bumi terletak segaris, dengan bulan terletak di tengah diantara keduanya, maka pada bagian tertentu 

dari bumi akan tertimpa bayangan bulan. Pengamatan gerhana matahari sangat berbahaya bila 

dilakukan secara langsung (dengan mata telanjang). Kita tidak boleh mengamati gerhana matahari 

secara langsung karena efek sinar UV yang dapat berbahaya bagi mata kita. Kita harus menggunakan 

alat pelindung khusus atau metode tertentu dalam mengamati gerhana matahari secara langsung. 

Pengamatan tersebut juga merupakan pengamatan tersulit mengingat cakupan bayangan bulan yang 

relatif kecil, yang mengakibatkan hanya sedikit daerah di permukaan bumi yang tertutup oleh 

bayangan bulan. Kecepatan rotasi dan revolusi dari Bumi dan Bulan juga mengakibatkan periode 

berlangsungnya gerhana yang sangat singkat. Langsung saja, kita akan mencoba simulasi gerhana 

matahari dengan menggunakan Stellarium. 

Mengamati Gerhana Matahari Total 

Gerhana matahari total terjadi apabila suatu area dipermukaan bumi terkena bayangan umbra dari 

bulan ketika menutupi sinar matahari. Pada tanggal 9 Maret 2016 saat pagi hari, diperkirakan akan 

terjadi gerhana matahari total yang melewati sebagaian kecil wilayah indonesia di Sumatera, 

Kalimantan, dan Sulawesi. Langsung saja kita buka Stellarium, lalu kita buka jendela waktu dengan 

mengklik ikon Date/time window pada toolbar di sebelah kiri atau tekan tombol F5. Setelah muncul 

jendela waktu, segera kita atur kolom tanggal dan waktu menjadi tanggal 2016/3/9 pukul 6:0:0. Tidak 

lupa kita hentikan jalannya waktu simulasi dengan mengklik ikon tombol play (Set normal time 

rate) atau tekan tombol K. Selanjutnya kita harus mencari lokasi pengamatan gerhana yang pas, 

karena gerhana matahari total hanya terjadi di sejumlah kecil area di Indonesia. Dan setelah dilakukan 

pencarian ternyata lokasi pengamatan yang sesuai adalah di kota Sampit, Kalimantan. Kita buka 

jendela lokasi dengan mengklik ikon Location window atau tekan tombol F6, lalu pada kolom 

pencarian (di samping gambar lup kecil) kita ketik “sampit”, maka muncul Sampit, Indonesia dalam 

pilihan tempat pengamatan. Setelah kita pilih (klik), lalu tekan tanda silang (close) pada jendela 

lokasi. 



 
Berikutnya karena kita akan mengamati Matahari, kita perlu mengatur fokus titik pengamatan pada 

matahari. Klik ikon Search window atau tekan tombol F3, lalu kita masukkan kata kunci “sun” dan 

tekan tombol enter. Nah…, disana telah nampak matahari dengan sebuah titik hitam yang ada di 

atasnya. Untuk memperjelas/memperbesar tampilan matahari, kita bisa menggunakan scroll keatas 

pada tetikus. 

 

Selanjutnya kita akan mengatur pergerakan waktu, mulai dengan menambah nilai menit. Klik tanda 

panah diatas kolom menit pada jendela waktu (Date&time window), setiap klik akan menambah satu 

menit. Pada pukul 6:26, bayangan bulan akan mulai menutupi matahari, dan puncaknya pada pukul 

7:30 akan terjadi gerhana matahari total selama kurang lebih 2 menit. Pada pukul 7:33 bayangan 

bulan mulai meninggalkan matahari dan akan benar-benar menghilang pada pukul 8:47. Sebagian 

kecil daerah di Sumatera, Kalimantan, dan Sulawesi akan dapat melihat gerhana matahari total, 

sementara untuk daerah lain di Indonesia hanya akan tampak sebagai gerhana matahari sebagian saja. 

 

Mengamati Gerhana Matahari Cincin 

Sedikit berbeda dengan gerhana matahari total, gerhana matahari cincin terjadi karena sebagian kecil 

permukaan bumi tertutup oleh bayangan antumbra (bayangan yang merupakan balikan (anti) dari 

umbra yang terjadi setelah melampaui titik fokus bayangan umbra). Akibatnya sinar matahari tidak 

tertutup sepenuhnya oleh bayangan bulan, melainkan timbul suatu bentukan cincin dari sinar matahari 

yang lolos dari penutupan bayangan bulan. Diperkirakan akan terjadi gerhana matahari cincin di 

indonesia (sebagian kecil Sumatera dan Kalimantan) pada tanggal 6 Desember 2019 saat siang hari. 

Kita buka Stellarium, lalu kita buka jendela waktu dengan mengklik ikon Date/time window pada 

toolbar di sebelah kiri atau tekan tombol F5. Setelah muncul jendela waktu, segera kita atur kolom 

tanggal dan waktu menjadi tanggal 2019/12/26 pukul 10:0:0. Tidak lupa kita hentikan jalannya waktu 

simulasi dengan mengklik ikon tombol play (Set normal time rate) atau tekan tombol K. Selanjutnya 

kita harus mencari lokasi pengamatan gerhana yang pas, karena gerhana matahari total hanya terjadi 

di sejumlah kecil area di Indonesia. Dan setelah dilakukan pencarian ternyata lokasi pengamatan yang 



sesuai adalah di kota Pekan Baru, Sumatera. Kita buka jendela lokasi dengan mengklik ikon Location 

window atau tekan tombol F6, lalu pada kolom pencarian (di samping gambar lup kecil) kita ketik 

“pekan baru”, maka muncul Pekan Baru, Indonesia dalam pilihan tempat pengamatan. Setelah kita 

pilih (klik), lalu tekan tanda silang (close) pada jendela lokasi. 

 

Kita fokuskan pengamatan kepada matahari. Pada penampakan matahari telah terlihat sebuah titik 

hitam yang ada di atasnya. Untuk memperjelas/memperbesar tampilan matahari, kita bisa 

menggunakan scroll keatas pada tetikus. Selanjutnya kita akan mengatur pergerakan waktu, mulai 

dengan menambah nilai menit. Pada pukul 10:25, bayangan bulan mulai menutupi matahari, dan 

puncaknya pada pukul 12:18 akan terjadi gerhana matahari cincin selama kurang lebih 2 menit. Pada 

pukul 12:20 bayangan bulan mulai meninggalkan matahari dan akan benar-benar menghilang pada 

pukul 14:14. Sebagian kecil daerah di Sumatera, Kalimantan, akan dapat melihat gerhana matahari 

total, sementara untuk daerah lain di Indonesia hanya akan tampak gerhana matahari sebagian saja. 

 

Gerhana Bulan 

Gerhana bulan memiliki beberapa perbedaan dengan gerhana matahari. Posisi bulan ada di belakang 

bumi, sehingga bulan tertutup oleh bayangan bumi. Kendati demikian, penampakan bulan tidak 

seluruhnya lenyap melainkan menjadi kemerahan atau hanya sedikit meredup. Hal tersebut 

diakibatkan masih adanya cahaya matahari yang menembus atmosfer bumi (dibelokkan) dan 

melewati wilayah bayangan bumi. Gerhana ini juga terjadi dalam tempo yang relatif lama serta 

cakupan wilayah yang lebih luas daripada gerhana matahari. Gerhana bulan dapat terjadi 2-3 kali 

dalam setahun. Terdapat beberapa macam gerhana bulan diantaranya gerhana bulan total, gerhana 

bulan sebagian, dan gerhana bulan penumbra. Berikut ini kita akan mencoba mengamati simulasi 

gerhana bulan total dengan memakai software Stellarium. 

Mengamati Gerhana Bulan Total 

Diperkirakan pada tanggal 28 Juli 2018 saat dini hari akan terjadi gerhana bulan total yang mencakup 

seluruh wilayah di Indonesia. Kita buka jendela waktu dengan mengklik ikon Date/time window 

pada toolbar di sebelah kiri atau tekan tombol F5. Setelah muncul jendela waktu, segera kita atur 

kolom tanggal dan waktu menjadi tanggal 2018/7/28 pukul 1:0:0. Tidak lupa kita hentikan jalannya 

waktu simulasi dengan mengklik ikon tombol play (Set normal time rate) atau tekan tombol K. 

Selanjutnya kita fokuskan pengamatan kepada bulan, klik ikon Search window atau tekan tombol 

F3, lalu kita masukkan kata kunci “moon” dan tekan tombol enter. Perjelas/perbesar tampilan bulan 

dengan menggunakan scroll keatas pada tetikus. Selanjutnya kita akan mengatur pergerakan waktu, 

mulai dengan menambah nilai menit pada jendela waktu. Gerhana ini terjadi di seluruh wilayah 

Indonesia dan nampak paling awal di Merauke sekitar pukul 1:30 serta berlangsung dini hari hingga 

malam hampir usai, dan paling akhir di Banda Aceh sekitar pukul 5:17. 

 

Mengamati Gerhana Menggunakan Script 

 

Apabila anda menginginkan sebuah tampilan instan mengenai gerhana matahari dan bulan, anda 

dapat memanfaatkan skrip yang tersedia di Stellarium. Caranya kita klik ikon Configuration window 

atau tekan tombol F2 hingga muncul jendela konfigurasi, lalu kita pilih menu tabulasi Scripts. Di 



dalam daftar list terdapat 3 skrip mengenai gerhana yaitu: lunar_partial.ssc, lunar _total.ssc, dan 

solar_eclipse.ssc. Anda tinggal memilih salah satu di antara ketiga skrip tersebut dengan cara 

mengklik pada daftar pilihan, lalu tekan tombol play yang terletak di bagian bawah jendela 

konfigurasi untuk menjalankannya. 

 

Demikian penjelasan mengenai cara mengamati gerhana menggunakan Stellarium. Sampai bertemu 

pada panduan berikutnya. 

Pengamatan Satelit dengan Stellarium 

 

Satelit merupakan objek ruang angkasa yang selalu mengorbit pada benda atau objek lain yang lebih 

besar. Secara umum terdapat 2 macam satelit yaitu satelit alam dan satelit buatan. Satelit alam atau 

sering disebut dengan bulan, merupakan objek ruang angkasa yang padat (sebagian besar tersusun 

atas batuan) yang mengelilingi planet-planet. Sementara itu satelit buatan adalah benda yang dibuat 

oleh manusia yang diedarkan ke luar angkasa untuk mengorbit pada suatu jalur tertentu. Berikut ini 

kita akan mengamati masing-masing satelit menggunakan Stellarium. 

Satelit alam 

Selain Merkurius dan Venus, seluruh planet di sistem tatasurya kita memiliki satelit alam. Satelit alam 

tersebut sering disebut sebagai bulan. Beberapa ada yang berukuran kecil, beberapa ada yang 

berukuran besar bahkan sebesar planet kerdil. Bumi kita juga memiliki sebuah bulan, yang telah kita 

amati sebelumnya (lihat panduan #2). Selain bulan yang dimiliki bumi, terdapat bulan-bulan lain yang 

menarik untuk kita amati. 

Berikut ini, kita akan mengamati bulan-bulan dari planet lain yang tidak kalah indahnya dari bulan 

kita. 

 

Bulan dari Mars 

Mars memiliki 2 bulan yang mengorbit padanya, yaitu Phobos dan Deimos. Dikarenakan 

penampakannya yang tidak beraturan, maka sebagian astronom menduga bahwa keduanya 

merupakan asteroid yang dulunya tetarik pada gravitasi Mars dan mengorbit padanya. 

Untuk mengamati bulan dari planet Mars, terlebih dulu kita atur waktu pengamatan, tekan tombol F5 

hingga keluar jendela waktu, lalu kita atur waktu pengamatan pada malam hari (sekitar pukul 22.00). 

Selanjutnya tekan tombol F3 untuk mengeluarkan jendela pencarian, lalu ketik kata kunci “mars“, 

lalu tekan enter. Setelah kita menyetel fokus pengamatan pada mars kita bisa memperbesar 

tampilannya dengan melakukan scroll keatas pada tetikus. Ketika diperbesar dan tampilan Mars 

cukup besar akan nampak 2 satelit yang berada di sekitarnya yaitu Phobos dan Deimos. Klik pada 

salah satu bulan tersebut untuk mengamati, sambil melakukan scroll ke atas atau menekan tombol 

slash (/) untuk meperbesar. 



 

Bulan dari Jupiter 

Sebagai sebuah planet “raksasa”, jupiter miliki setidaknya 63 bulan yang mengorbit padanya. Empat 

bulan terbesar dari Jupiter telah berhasil diamati sejak teleskop ditemukan. Keempat bulan itu adalah 

Io, Europa, Ganymede, dan Callisto, keempatnya sering disebut dengan bulan-bulan Galilean karena 

diamati oleh Gallieo pada 1609. Ganymede merupakan bulan terbesar di tatasurya kita, dengan 

ukuran melebihi planet Merkurius. Ia juga bulan yang memiliki aktivitas vulkanik (gunung api). 

Untuk mengamati bulan-bulan Galilean kita bisa menggunakan cara yang telah disebutkan pada 

pengamatan bulan dari planet Mars. Atau kalau kita hanya ingin mengamati masing-masing dari 

keempat bulan itu saja, kita bisa langsung mencarinya. Tekan tombol F3 untuk mengeluarkan jendela 

pencarian. Kita ketikkan nama dari salah satu bulan Galilean, misalnya “ganymede” lalu tekan enter. 

Selanjutnya kita perbesar tampilannya dengan melakuan scroll ke atas pada tetikus atau tekan tombol 

slash (/). Lakukan cara yang sama untuk mengamati bulan Galilean yang lain. 

 
Hint: terkadang dalam pengamatan tampilan Jupiter atau bulan-bulan pengiringnya tidak nampak 

karena berada di balik belahan bumi. Untuk itu kita perlu menonaktifkan fitur ground, dengan 

mengklik ikon Ground pada toolbar atau tekan tombol G. 

Bulan dari Saturnus 

Planet ini setidaknya memiliki 60 bulan yang mengorbit padanya. Salah satu yang terkenal dan 

menjadi perhatian para ilmuan adalah Titan. Titan diduga memiliki atmosfer yang tersusun sebagiaan 

besar oleh nitrogen, bahkan beberapa peneliti berpendapat bahwa terdapat kemungkinan mengenai 

adanya bentuk kehidupan yang sederhana padanya. 

Untuk mengamati Titan, mula-mula tekan tombol F3 untuk mengeluarkan jendela pencarian. Kita 

ketikkan “titan” lalu tekan enter. Selanjutnya kita perbesar tampilannya dengan melakuan scroll ke 

atas pada tetikus atau tekan tombol slash (/). 



 

Hint: Apabila kita ingin mengamati bulan-bulan lain yang mengorbit pada Saturnus, kita bisa sedikit 

melakukan scroll ke bawah (memperjauh tampilan). 

Bulan dari Uranus 

Uranus memiliki sedikitnya 27 bulan. 5 diantaranya merupakan bulan terbesar mulai dari: Titania, 

Oberon, Umbriel, Ariel, dan Miranda. Para ilmuwan tertarik untuk mengamati Miranda karena 

permukaannya yang sangat ridak rata dan terdapat cekungan serupa goresan. Diduga bulan ini pernah 

mengalami beberapa kali tabrakan besar. 

Untuk mengamati Miranda, mula-mula tekan tombol F3 untuk mengeluarkan jendela pencarian. Kita 

ketikkan “miranda” lalu tekan enter. Selanjutnya kita perbesar tampilannya dengan melakuan scroll 

ke atas pada tetikus atau tekan tombol slash (/). Lakukan sedikit scroll ke bawah untuk mengamati 

bulan-bulan lain yang mengorbit pada Uranus. 

 

Bulan dari Neptunus 

Neptunus memiliki 13 bulan, yang terbesar adalah Triton. Triton memiliki orbit yang berlawanan arah 

dengan bulan-bulan Neptunus lainnya. Triton juga merupakan bulan yang tersusun atas batuan dan es 

dengan permukaan paling dingin di tatasurya (berkisar -235C) 

Untuk mengamati Triton, mula-mula tekan tombol F3 untuk mengeluarkan jendela pencarian. Kita 

ketikkan “triton” lalu tekan enter. Selanjutnya kita perbesar tampilannya dengan melakuan scroll ke 

atas pada tetikus atau tekan tombol slash (/). Lakukan sedikit scroll ke bawah untuk mengamati 

bulan-bulan lain yang mengorbit pada Neptunus. 

 

Bulan dari Pluto 

Kendati pluto tidak lagi digolongkan sebagai planet utama, namun para ilmuwan telah berhasil 

mengamati 3 bulan yang mengorbit padanya. Ketiga bulan tersebut adalah Charon, Nix dan Hydra. 

Dari ketiganya, Charon adalah yang terbesar. 

Untuk mengamati Charon, mula-mula tekan tombol F3 untuk mengeluarkan jendela pencarian. Kita 

ketikkan “charon” lalu tekan enter. Selanjutnya kita perbesar tampilannya dengan melakuan scroll 

ke atas pada tetikus atau tekan tombol slash (/). Lakukan sedikit scroll ke bawah untuk mengamati 

bulan-bulan lain yang mengorbit pada Pluto. 

 

Satelit buatan 

Kita sebagai orang Indonesia tentunya pernah bangga (sekaligus kecewa) ketika disebut nama satelit 

Palapa. Ya satelit Palapa merupakan salah satu benda buatan manusia yang diluncurkan ke ruang 

angkasa. Sejarah mencatat Sputnik 1 sebagai satelit buatan yang diluncurkan pertama kali ke luar 

angkasa. Ia merupakan satelit berbentuk bola dengan dameter 58 cm yang diluncurkan oleh Uni 

Soviet pada 4 Oktober 1957. Kini ribuan satelit telah diluncurkan ke ruang angkasa untuk berbagai 

keperluan, mulai dari: pengamatan cuaca, pencitraan permukaan bumi, pemancar gelombang radio, 

peneropong bintang, hingga satelit yang bertugas untuk mata-mata dan kegiatan militer. 

Satelit buatan terbuat dari bahan-bahan yang ringan, seperti aluminium, panel surya untuk catudaya, 

dan dilengkapi dengan berbagai rangkaian elektronik serta perangkat yang berhubungan dengan 

fungsi dari masing-masing satelit. Orbit satelit buatan menempati salah satu dari 4 tipe orbit utama, 



yaitu orbit polar/kutub (melintasi kutub), orbit geostasioner (berada pada jarak tetap diatas bumi), 

orbit lingkar/rendah (berada pada suatu jarak rendah di atmosfer bumi), dan orbit eksentrik (beredar 

pada jarak yang berubah-ubah). 

Kita bisa mengamati satelit buatan dengan menggunakan Stellarium. Caranya sangat mudah yaitu 

kita tinggal mengklik ikon Satellite hints pada toolbar atau dengan menekan tombol Ctrl+Z, maka 

seketika di langit akan muncul tampilan satelit berserta nama dan jalur orbitnya masing-masing. 

Apabila kita kurang jelas dalam pengamatan satelit ini kita bisa menonaktifkan fitur ground (tekan 

tombol G) atau dengan berpindah lokasi pengamatan, misalnya ke belahan bumi atau kota yang lain, 

menggunakan jendela lokasi (tekan tombol F6). 

 
Hint: berikut adalah keterangan beberapa satelit buatan yang teramati dengan Stellarium 

 HST (Hubble Space Telescope) merupakan teleskop ruang angkasa yang ditujukan untuk 

mengambil penampakan objek-objek ruang angkasa  

 ISS (International Space Station) merupakan semacam stasiun ruang angkasa dan  struktur 

terbesar yang dibangun di luar angkasa oleh manusia. ISS memiliki fungsi utama sebagai 

tempat riset berkenaan dengan hal-hal keruangangkasaan  

 ENVISAT satelit milik Europa Space Agency yang berfungsi untuk emngobservasi keadaan 

bumi, darat dan lautnya.  

 NOAA merupakan satelit-satelit ruang angkasa milik badan National Oceanic and 

Atmospheric Administration milik amerika. Satelit ini berfungsi mengamati cuaca ayng 

terjadi terutama di Amerika  

  



Pengamatan Asteroid dan Meteor dengan Stellarium 

 

Ketika Eris ditemukan, para astronom memperdebatkan statusnya, apakah sebagai planet atau hanya 

sebuah asteroid?. Hingga pada sidang astronomi internasional di Praha tahun 2006, memutuskan 

beberapa resolusi diantaranya syarat sebuah benda dikatakan sebagai planet. Syarat tersebut antara 

lain: 1. mengorbit matahari, 2. berukuran cukup besar sehingga mampu mempertahankan bentuknya 

yang bulat, 3. memiliki jalur orbit yang bersih dan jelas (tidak ada benda langit lain di orbit tersebut). 

Dengan adanya persyaratan tersebut maka Eris tidak digolongkan sebagai sebuah planet, bahkan 

Pluto pun harus “angkat kaki” dari jajaran planet utama penyusun tata surya. 

Asteroid 

Asteroid merupakan benda luar angkasa berupa batu atau logam yang berukuran cukup besar, 

Asteroid kadang disebut sebagai planetoid atau planet kerdil. Asteroid memiiliki ukuran yang 

beragam, dengan rata-rata diameternya adalah 1 km. Asteroid pertama dan terbesar yang ditemukan 

adalah Ceres. Ia memiliki diameter 932 km dan berada di sabuk asteroid, yaitu suatu kawasan orbit 

dari asteroid-asteroid yang terletak antara Mars dan Jupiter (berjarak antara 1,4-6 AU dari bumi). 

Selain di kawasan sabuk asteroid, terdapat asteroid dan benda-benda angkasa yang beredar di sabuk 

kuiper, yaitu suatu kawasan di luar orbit Neptunus (berjarak lebih dari 28 AU dari bumi). 

 

Mengamati Asteroid 

Untuk mengamati asteroid, kita bisa menggunakan bantuan Stellarium. Kita akan mencoba 

mengamati beberapa asteroid selain Ceres, yang telah berhasil ditemukan oleh para astronom. 

Pertama, kita akan mengamati asteroid yang bernama Vesta. Bukalah aplikasi Stellarium, lalu buka 

jendela pencarian dengan mengklik ikon Search window pada toolbar atau tekan tombol F3. 

Selanjutnya ketikkan “vesta” dan tekan tombol enter. Seketika kita akan dibawa untuk melihat 

asteroid Vesta, Gunakan tombol / (slash) untuk memperbesar objek. dari keterangan pada indikator 

jarak (Distance) kita bisa memperkirakan bahwa Vesta merupakan salah satu asteroid yang menghuni 

zona sabuk asteroid. 

 

Anda bisa mengulangi langkah di atas untuk melihat asteroid yang berukuran relatif besar, beberapa 

diantaranya adalah Pallas dan Juno. 



 

Meteoroid 

Meteoroid adalah benda angkasa yang terbuta dari batuan dan logam yang ukuran diameternya tidak 

lebih dari 10 m. Beberapa meteorioid berasal dari serpihan yang terlontar ke ruang angkasa akibat 

hasil tumbukan antara asteroid atau komet dengan bulan-bulan (satelit alami dari planet) maupun 

planet. Ketika memasuki atmosfer bumi meteoroid biasanya akan mengeluarkan cahaya akibat 

bergesakan dengan atmosfer yang sering disebut masyarakat sebagai meteor. Karena ukurannya yang 

relatif kecil, maka sebagian besar meteor akan habis sebelum berhasil menghantam permukaan bumi. 

Mengamati hujan meteor 

Untuk mensimulasikan hujan meteor kita bisa menggunakan fitur Shooting Stars. Kita buka jendela 

View dengan mengklik ikon Sky and viewing options window atau tekan tombol F4. Pada tabulasi 

Sky lihatlah bagian Shooting Stars yang berada paling bawah. Selanjutnya kita bisa ngatur rerata 

turunnya meteor dengan mengklik (memilih) salah satu pada pilihan yang ada. 

 

Hint: meteor biasanya mulai nampak terlihat mulai tengah malam (diatas pukul 23:00), gunakan 

jendela waktu (tekan F5) untuk mengatur waktu pengamatan. 

 

Demikian panduan pengamatan Stellarium kali ini, semoga bermanfaat dan sampai jumpa pada 

panduan yang lain. 

 

  



Pengamatan Rasi Bintang dengan Stellarium 

 

Beberapa dari kita tentu masih ingat, dulu di jaman sekolah dasar pada pelajaran IPA terdapat materi 

tentang ilmu perbintangan. Saat musim tertentu pada arah tertentu, di langit malam terdapat suatu rasi 

bintang yang menandakan pergantian musim. Kita juga diberitahu oleh guru atau orang tua kita bahwa 

para nelayan dan pelaut memakai bintang-bintang sebagai penunjuk arah ketika mereka berada di laut 

saat malam tiba. 

Pengamatan bintang sendiri telah dilakukan oleh manusia sejak jaman dahulu kala. Terdapat sebuah 

cabang ilmu pengetahuan (sains) yang mengkhususkan diri terhadap pengamatan benda benda langit 

terutama bintang, ilmu tersebut dinamakan ilmu Astronomi. Apakah anda pernah mendengar 

Astrologi atau ilmu tentang zodiak? Kenapa pertanyaan ini saya ajukan terlebih dahulu, karena 

nantinya kita juga akan menemui beberapa istilah yang sama dengan apa yang ditemukan dalam ilmu 

astronomi, seperti nama rasi bintang misalnya. Ilmu Astronomi dibedakan dengan Astrologi karena 

Astronomi mempelajari secara ilmiah mengenai angkasa dan segala isinya. Sedangkan Astrologi 

tidak ilmiah dan menganjurkan kepercayaan bahwa bintang atau benda langit dapat mempengaruhi 

kehidupan atau nasib manusia, yang dengan kata lain dilandasi oleh takhayul. Jadi, yang perlu 

digarisbawahi adalah kita disini mempelajari sesuatu yang ilmiah karena kita ingin supaya mendapat 

manfaat dari apa yang kita pelajari. Selanjutnya saya mencoba mengutip pernyataan dari seorang 

ilmuwan arab zaman dahulu yang terkemuka pada yaitu Qatadah, beliau mengatakan: “Bintang itu 

diciptakan untuk tiga perkara: hiasan di langit, pelempar syeitan, dan penunjuk arah. Barang siapa 

yang menakwilkannya selain itu (membuat tafsiran, ramalan zodiak, takhayul, dsb), maka ia telah 

melakukan kesalahan dan menyia-nyiakan bagiannya, serta membebani dirinya untuk sesuatu yang 

tidak dimiliki ilmunya”. 

Kali ini kita akan melakukan pengamatan bintang secara ilmiah dan memanfaatkannya untuk 

kehidupan kita sehari-hari. Melanjutkan panduan yang telah lalu, kita akan mencoba lakukan 

pengamatan konstelasi bintang dengan menggunakan Stellarium. Dari pengamatan tersebut kita bisa 

memanfaatkannya untuk: perkiraan arah, perkiraan musim, rencana pengamatan bintang secara 

langsung, atau untuk sarana pendidikan dan hiburan  . 

A. Pengamatan rasi bintang Crux 

Seperti yang telah disebutkan sebelumnya, mengetahui konstelasi (rasi) bintang di saat malam akan 

sangat membantu dalam menentukan arah mata angin. Secara umum terdapat 2 kelompok konstelasi 

bintang dilihat dari bumi yaitu: konstelasi bintang pada belahan bumi selatan dan konstelasi bintang 

pada belahan bumi utara. Terrdapat beberapa rasi bintang yang menjadi penanda arah utara dan 

selatan. 

Untuk memulai kegiatan pengamatan konstelasi bintang, kita buka aplikasi stelarium 

Applications -> Science -> Stellarium 

Kita akan mencoba mengamati salah satu rasi bintang yang menunjukkan arah selatan, yaitu Crux 

(salib selatan). 

Klik ikon Search window pada toolbar di sebelah kiri atau tekan tombol F3, setelah muncul jendela 

pencarian kita ketikkan “crux“, maka seketika kita akan dibawa pada tampilan konstelasi bintang 

Crux. 



 
Pada awalnya mungkin kita hanya menemukan tampilan sekumpulan bintang yaitu: Mimosa, Gacrux 

dan Acrux, untuk memperjelas penampilan rasi bintang Crux kita bisa menggunakan atau 

mengaktifkan beberapa alat bantu (tool) konstelasi. Aktifkan (klik) ikon Constellation Lines pada 

bagian kiri bawah toolbar atau bisa dengan menekan tombol C, maka akan tampak garis konstelasi 

dari rasi Crux. Selanjutnya kita juga bisa menampilkan nama atau label konstelasi dengan 

mengaktifkan (klik) ikon Constellation Labels atau dengan menekan tombol V. Kita juga bisa 

menggunakan tombol scroll pada tetikus untuk memperbesar dan memperkecil tampilan. 

 

B. Pengamatan rasi bintang Waluku (Ursa Mayor) 

Kali ini kita akan mencoba mengamati rasi bintang Waluku (gayung terbalik) atau Ursa Major, yang 

sering digunakan sebagai penanda arah utara. 

Klik ikon Search window pada toolbar di sebelah kiri atau tekan tombol F3, setelah muncul jendela 

pencarian kita ketikkan “ursa major“, maka seketika kita akan dibawa pada tampilan konstelasi 

bintang Ursa Major. 



 
Ursa Major di dunia barat sering dikenal sebagai rasi bintang beruang besar. Hal ini bisa diketahui 

dengan mengaktifkan (klik) tool Constellation art pada toolbar konstelasi atau dengan menekan 

tombol R. 

 
Dalam budaya kita (indonesia) rasi ini dikenal sebagai rasi biduk raksasa atau gayung raksasa karena 

bagian ekor dari rasi Ursa Major membentuk susunan yang mirip gayung raksasa yang terbalik. Selain 

untuk menentukan arah utara, munculnya rasi ini biasanya digunakan sebagai penanda akhir musim 

hujan atau awal musim kemarau. Kita bisa membuktikannya dengan mengatur pergerakan waktu pada 

jendela waktu (Date/time window). Kita klik ikon jendela waktu (Date/time window) atau dengan 

menekan tombol F5. Setelah muncul jendela waktu, kita ubah nilai dari kolom bulan (kedua dari kiri) 

dengan mengklik tanda panah diatas atau dibawahnya. Kita klik secara berurutan mulai dari bulan 1 

sampai 12. Coba anda perhatikan, rasi bintang Ursa Major mulai nampak jelas di atas belahan langit 

utara ketika nilai bulan menunjukkan angka 4 atau bulan April, sedangkan pada bulan April biasanya 

hujan sudah mulai berkurang. Oleh karena itu para nenek moyang kita menjadikan rasi ini sebagai 

penanda pergantian antara musim hujan ke kemarau. 



 

 

Dalam kebudayaan lain, rasi ini memiliki beragam nama. Salah satunya adalah rasi Caribou dalam 

kebudayaan Inuit (Eskimo). Anda bisa melihat berbagai penamaan rasi melalui jendela View. Klik 

ikon Sky and viewing option windows pada menu pop up di sisi kiri atau tekan tombol F4, lalu pilih 

menu tabulasi Starlore dan anda tinggal memilih pada daftar kebudayaan yang ada (defaultnya 

adalah western). 

C. Pengamatan “penghuni” langit selatan dan utara 

Setelah mengamati rasi bintang Crux dan Ursa Mayor, kita mungkin merasa penasaran dengan 

berbagai rasi bintang yang ada di masing-masing belahan langit selatan dan utara. kita bisa 

memanfaatkan fasilitas berupa garis bantu ekuatorial dalam membantu kegiatan di tiap belahan langit. 

Klik ikon Equatorial grid pada toolbar di bagian bawah, atau tekan tombol E. Setelah muncul garis 

bantu ekuatorial kita bisa melihat pada masing-masing belahan langit. Pada belahan langit utara, nilai 

derajat lintangnya adalah positif (+), sebaliknya pada belahan langit selatan nilai derajat lintangnya 

adalah negatif (-). 

Dengan menggunakan tambahan bantuan toolbar alat konstelasi (Constelllation Lines, 

Constellation Labels, dan Constellation Art), kita bisa melihat beberapa rasi bintang yang 

merupakan anggota dari tiap belahan langit. Kita juga bisa menampakkan garis bantu pembatas tiap 

area rasi bintang yaitu Constellation boundaries untuk membantu pengamatan terhadap rasi bintang. 

Caranya dengan menekan tombol B atau anda bisa mengaktifkannya pada bagian Constellations 

tabulasi Markings di jendela View. 

 
Berikut adalah beberapa rasi pada belahan langit selatan yang dapat kita jumpai: Crux, Scorpio, Libra, 



Triangulum Australe, dll. 

Sementara itu, pada belahan langit utara kita bisa melihat rasi bintang: Ursa Major, Corona Borealis, 

Gemini, Leo, dsb. 

 

  

 

Sebelum saya mengakhiri tulisan ini saya ingin menyampaikan hal yang penting yaitu Seting tempat 

dan waktu pengamatan sangat mempengaruhi hasil pengamatan. Pada pengamatan yang saya lakukan 

disini, saya mengatur lokasi pengamatan di kota Semarang, Indonesia, dengan waktu pengamatan 

bervariasi antara pukul 20.00-23.00. Tentunya akan hasil pengamatan yang anda lakukan akan 

berbeda, jika anda menggunakan seting tempat dan waktu yang berbeda.  

Demikian panduan pengamatan rasi bintang dengan Stellarium, semoga menginspirasi dan menjadi 

manfaat bagi kita. 

 

  



Pengamatan Bintang dan Galaksi dengan Stellarium 

 

Bintang merupakan sebuah bola gas raksasa yang sangat panas. Sejauh yang telah mampu diamati 

dan diperkirakan oleh manusia, bintang memiliki beragam ukuran, suhu, dan spektrum warna yang 

berbeda-beda. Matahari sebagai bintang dalam tatasurya kita tergolong sebagai bintang kerdil 

berwarna kuning. Namun demikian matahari bukanlah yang terkecil diantara semua bintang. Bintang 

kerdil putih memiliki ukuran 100 kali lebih kecil dari matahari. Sementara itu banyak bintang yang 

berukuran puluhan hingga ratusan kali lebih besar dari matahari. 

Bintang-bintang tersebut berkumpul dalam suatu gugusan yang besar yang disebut sebagai galaksi. 

Matahari merupakan salah satu dari miliaran bintang yang menyusun galaksi Bimasakti (Milky Way). 

Galaksi kita sendiri merupakan satu dari miliaran galaksi yang menyusun alam semesta. Subhanalloh, 

betapa luas dan besarnya ciptaan dari Yang Maha Pencipta. 

Sejak jaman dahulu manusia telah mengamati bintang di langit. Dari pengamatan sederhana tanpa 

alat bantu yaitu mengamati rasi bintang hingga berkembangya teleskop dan wahana pengamatan 

ruang angkasa. 

Pada panduan kali ini kita akan mengamati bintang secara lebih dekat, kemudian kita lanjutkan untuk 

mengamati galaksi-galaksi. Sebelum melakukan pengamatan bintang dan galaksi (termasuk benda 

langit lainnya) ada beberapa hal penting yang ingin saya sampaikan: 1) sangat penting bagi kita untuk 

mengatur lokasi dan waktu pengamatan. Terlebih dahulu kita akan mengatur tempat pengamatan yaitu 

di observatorium Lembang. Tekan tombol F6, lalu ketikkan kata kunci lembang dan pilihlah (klik) 

Lembang, Indonesia pada daftar lokasi pengamatan. 2) pada pengamatan bintang dan galaksi, sangat 

penting bagi kita untuk memahami konsep rasi bintang terlebih dahulu (lihat panduan #7). 

 

Pengamatan bintang terdekat 

Proxima adalah bintang yang menjadi tetangga terdekat matahari. Untuk mengamatinya kita perlu 

mengatur waktu pengamatan. Kita tekan F5 sehingga muncul jendela waktu, lalu kita ubah nilainya 

menjadi 2014/5/1 23:0:0. Selanjutnya bula jendela pencarian dengan menekan tombol F3 lalu 

ketikkan “proxima” dan tekan enter. Kita bisa menggunakan scrool keatas atau tombol Page Up 

untuk memperbesar tampilan bintang tersebut. 

 
Proxima memiliki nama lain Alpha Centauri C. Nama tersebut dihasilkan dari letak gugus rasi bintang 

dimana ia berada yaitu Centaurus, kemudian diubah menjadi nama genatifnya yaitu Centauri. 

http://panduan.blankonlinux.or.id/pendidikan/pengamatan-rasi-bintang-dengan-stellarium-7/


Sedangkan istilah Alpha menunjukkan tingkat kecerahannya dalam suatu gugus rasi bintang, dimana 

Alpha merupakan yang tercerah, diikuti Beta, Gama, dan seterusnya. Penamaan yang sama juga 

berlaku pada bintang-bintang lain dalam suatu gugus rasi bintang. 

Pada indikator objek kita bisa melihat tingkat kecemerlangan dari suatu bintang. Nilai Magnitude 

menandakan kecemerlangan bintang yang tampak di langit saat pengamatan berlangsung, semakin 

negatif nilai Magnitude maka semakin cemerlang bintang tersebut. Sementara itu nilai Absolute 

Magnitude menandakan seberapa banyak cahaya yang dapat dipancarkan. Spectral Type 

menandakan nilai ionisasi spektrum cahaya yang dihasilkan oleh bintang berdasarkan klasifikasi 

Morgan-Keenan. Dengan melihat nilai Absolut Magnitude dan Spectral Type, kita bisa menduga 

bahwa proxima merupakan sebuah bintang merah kerdil. Nilai Absolut Magnitudenya 15.44 

sedangkan Spectral Typenya M5Ve dan jika kita komparasi pada diagram Hertzsprung-Russell, 

maka Proxima akan masuk ke dalam golongan V atau bintang Rangkaian Utama yang berukuran 

kecil. 

Pada indikator objek juga dapat kita amati jarak (Distance) Bumi ke Proxima yaitu 4.22 tahun cahaya 

atau 40.09 triliun km (1 tahun cahaya bernilai 9.5 triliun km). Sebagai perbandingan jarak Bumi ke 

Matahari kira-kira sejauh 149,6 juta km. Subhanalloh, jauh sangat ya bintang terdekat ini :D. 

Kita juga bisa mengamati bintang-bintang yang lain baik dengan menggunakan jendela pencarian 

(misal mencari bintang Banard), maupun dengan cara langsung mengklik (memilih) pada rasi bintang 

yang ada (misal binatang Betelgeuse pada rasi Orion), atau sembarang bintang yang ada di bidang 

pandang. 

 

Pengamatan galaksi tetangga 

Galaksi merupakan sebuah sistem gravitasional yang masif, yang terdiri atas bintang, sisa-sisa atau 

pendamping bintang, medium antar bintang yang berupa gas dan debu, serta materi gelap (sebuah 

komponen yang sangat sedikit dipahami :D). Galaksi sering juga disebut sebagai nebula, hanya saja 

istilah nebula lebih sering digunakan untuk menamai gumpalan gas dan awan debu raksasa yang 

menyertai bintang. Matahari kita merupakan salah satu dari miliaran bintang yang menyusun galaksi 

Bimasakti. Begitu luasnya sistem suatu galaksi sehingga tak terbayangkan lagi cara mengukurnya. 

Galaksi Bimasakti saja berdiameter 100000 tahun cahaya (silahkan konversi sendiri nilainya dalam 

km :D). Subhanalloh, Maha Agung dan Maha Besar pencipta alam semesta. Tata surya kita berada di 

lengan dari galaksi Bimasakti, oleh karena itu kita kesulitan untuk melihat dari luar galaksi kita ini. 

Bayangkan berapa jarak yang harus ditempuh untuk melihatnya dari luar :D. Untungnya kita masih 

bisa melihat galaksi lain yang bertetangga dengan galaksi kita. salah satunya adalah galaksi 

Andromeda. 



 
Mula mula kita atur seting waktu pengamatan, tekan tombol F5, lalu ubah tanggalnya menjadi 

2014/11/1 dan pukul 23:0:0. Selanjutnya kita cari rasi Andromeda, tekan tombol F3 lalu ketik 

“andromeda“, seketika kita akan dibawa ke rasi bintang Andromeda. Berikutnya kita tekan ikon 

Nebulas pada toolbar atau tekan tombol N, sehingga muncul titik dan label nama-nama galaksi yang 

ada. Kita pilih (klik) pada titik Great Nebula in Andromeda. lalu kita tekan tombol Spasi untuk 

mengunci target pengamatan. Setelah terkunci kita tinggal memperbesar tampilan menggunakan 

scroll ke atas pada tetikus atau tekan tombol Page Up. Akan tampak galaksi Andromeda dalam 

bentuk spiral yang menakjubkan. 

 
Hint: Dalam penamaan internasional dikenal 2 penamaan galaksi, yaitu memakai kode M dan 

memakai kode NGC. Kode M dipakai untuk menghormati seorang ilmuwan bernama Charles Meiser 

yang telah terlebih dulu mengkatalogkan galaksi. Selanjutnya dikarenakan lebih banyaknya galaksi 

dan benda langit yang ditemukan maka dibuat katalog penamaan yang terbaru yang diberi kode NGC 

(New General Catalogue). 

Para ilmuwan mengelompokkan galaksi menurut bentuknya kedalam 3 golongan, yaitu galaksi oval 

(misal galaksi M87) , galaksi spiral (misal galaksi Andromeda dan galaksi M100), serta galaksi tak 

beraturan (nebula). Galaksi yang banyak material gas dan asap yang sering disebut sebagai nebula. 

Berikutnya kita akan mengamati nebula KepalaKuda dan nebula Orion yang terletak di rasi bintang 

Orion. Kita bisa mengaplikasikan cara yang sama dengan pencarian galaksi Andromeda, atau 

menggunakan cara cepat hehe, yaitu dengan memakai jendela pencarian. Ketik F3 setelah muncul 

jendela pencarian kita isikan “horsehead nebula“, maka seketika kita akan dibawa ke nebula 

KepalaKuda. 



 

Hint: ada 3 tipe umum dari awan pembentuk nebula yaitu: awan nebula emisi (memancarkan sinar 

sendiri), awan nebula refleksi (memantulkan sinar dari bintang terdekat), dan awan nebula gelap 

(tampak gelap /menyerap sinar yang ada di belakangnya). Kita bisa melihat ketiganya pada nebula 

KepalaKuda. 

Sedikit perkecil tampilan nebula KepalKuda dengan scroll ke bawah pada tetikus atau menekan 

tombol Page Down, maka akan tampak nebula besar Orion (Great Nebula in Orion). Klik pada 

nebula tersebut, dan tekan tombol Spasi untuk mengunci target pengamatan, lalu perbesar 

tampilannya dengan scroll ke atas pada tetikus atau tekan tombol Page Up. 

 

Anda bebas menggunakan cara yang sama untuk mencari galaksi dan nebula yang lain. Bila 

pengamatan kita berada dibalik belahan bumi, kita tinggal menonaktifkan fitur Ground (tekan tombol 

G), untuk mengamati galaksi-galaksi yang kita cari. Berikut adalah nebula yang saya rekomendasikan 

untuk dilihat: nebula kepiting (Crab Nebula, diduga merupakan sisa hasil sebuah ledakan supernova), 

Rossete nebula, California nebula, Trifid nebula, Eagle nebula, galaksi M64, M79, M100. 

 

Pengamatan Cluster 

Sistem bintang yang lebih kecil dari galaksi sering disebut sebagai gugus (Cluster). terdapat 2 jenis 

gugus yang sering dijumpai yaitu gugus globuler dan gugus terbuka. Gugus globuler (globular 

cluster) merupakan gugus yang berisi ratusan ribu bintang yang disatukan oleh gravitasi yang saling 

tarik menarik. Susunan bintangnya rapat dan berbentuk hampir bulat atau tampak sebagai gumpalan 

kabur di pengamatan teleskop biasa. Di bagian tengah gugus ini berisi bintang-bintang tua. Gugus 

terbuka (open cluster) merupakan gugus yang berisi beberapa ratus bintang saja. Gugus ini tersusun 

longgar dan terdiri dari bintang-bintang muda dan panas. 

Untuk pengamatan contoh gugus-gugus tersebut kita bisa menggunakan jendela pencarian di 

stellarium. Tekan F3 untuk membuka jendela pencarian, lalu ketikkan “Double cluster” (NGC869). 

Seketika kita akan dibawa ke gugus Double cluster yang merupakan gugus terbuka (Open Cluster). 

Perbesar tampilan gugus dengan melakukan scroll ke atas pada tetikus atau tekan tombol Page Up. 

Ulangi cara yang sama untuk melihat gugus yang lain. Sementara untuk melihat contoh gugus 

globuler, kita bisa melihat contohnya pada gugus NGC104. 

 

Hint: anda bisa melihat contoh gugus, galaksi, maupun nebula, dengan mengaktifkan fitur Nebulas 

(tekan tombol N) lalu mengklik pada tanda dan label nebula yang muncul. Jangan lupa gunakan scroll 

ke atas atau tombol Page Up untuk memperbesar tampilan 

Demikian penjelajahan kita dalam mengamati alam semesta. Capek juga ya menjelajahi jutaan tahun 

cahaya :D. Semoga serial panduan pengamatan dengan Stellarium ini mampu menambah 

pengetahuan kita serta memberi manfaat bagi kita semua. 

 



Membuat Lanskap Panorama Pribadi pada Stellarium 

 

Pada panduan-panduan Stellarium yang sebelumnya, kita telah mengamati berbagai benda langit 

menggunakan Stellarium. Mungkin di antara kita, terbersit keinginan untuk mengkostumasi tampilan 

lanskap di Stellarium. Hal tersebut bisa saja terwujud dengan sedikit berusaha memahami lebih lanjut 

seting modifikasi  pada Stellarium. Setidaknya terdapat tiga metode kostumasi lanskap pada 

Stellarium, yaitu: metode Single Fish-Eye, metode Single Spherical, dan metode Multiple Image (old 

style). 

Metode Multipe Image merupakan metode pembuatan lanskap Stellarium dengan memakai gambar 

panorama 360 ° yang telah dipotong menjadi beberapa bagian yang disebut “side texture”, disertai 

dengan gambar permukaan tanah yang sisebut “ground texture”. Keunggulan dari metode ini antara 

lain: meningkatkan detil dari gambar horison tanpa harus membuatnya dalam sebuah file panorama 

yang besar, gambar permukaan tanah dapat menggunakan resolusi yang rendah, penggunaan memori 

komputer akan lebih rendah dibandingkan dengan teknik yang lain. Adapun kelemahan dari teknik 

ini adalah pembuatan file “side texture” yang relatif lebih rumit dari metode yang lain, serta seting 

file konfigurasi landscape.ini yang sedikit lebih rumit. Selanjutnya kita langsung akan membahas cara 

pembuatan lanskap pribadi di Stellarium menggunakan metode Multiple Image. 

Pembuatan file gambar “side texture” 

Telah disebutkan bahwa dalam metode Multiple Image ini kita perlu membuat gambar panorama 

360 °. Gambar panorama tersebut dapat kita buat dengan menggunakan kamera digital biasa. Suatu 

catatan tambahan yang penting adalah, hendak kita menggunakan kompas dalam pengambilan foto 

panorama. Penggunaan kompas nantinya akan mempermudah pengurutan gambar panorama, dengan 

bagian sisi kiri gambar segaris dengan salah satu arah mata angin (usahakan mulai dari bagian timur). 

Setelah mengambil foto-foto, kita dapat menyusunnya menjadi sebuah gambar panorama 360 ° 

dengan bantuan aplikasi GIMP serta skrip Pandora. Pembahasan mengenai pembuatan gambar 

panorama dapat anda simak secara lengkap di panduan “Membuat Gambar Panorama dengan GIMP 

dan Pandora”. 

Setelah membuat sebuah gambar panorama 360 °, langkah selanjutnya adalah menghilangkan 

tampilan langit pada gambar serta menggantinya dengan bidang transparansi. Kita dapat melakukan 

nya dengan menggunakan berbagai tool seleksi dari toolbox GIMP. Pertama terlebih dulu kita 

aktifkan trasparansi dengan memilih menu Layer → Transparency → Add Alpha Channel. 

Berikutnya kita menyeleksi seluruh tampilan langit dalam gambar, saya sarankan menggunakan 

Fuzzy Select Tool (tekan tombol U) atau Scissor Select Tool (tekan tombol I) untuk mempermudah 

penyeleksiannya. Setelah terseleksi, kita tekan tombol Delete untuk menghapus semua tampilan 

langit dan menyisakan area berisi kotak-kotak (transparansi). 

  

http://panduan.blankonlinux.or.id/pendidikan/pengenalan-stellarium-1/
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Masuk ke tahap berikutnya, kita perlu membagi sebuah gambar panorama 360 ° ke dalam delapan 

bagian. Delapan bagian tersebut mewakili delapan arah mata angin yaitu: Timur, Tenggara, Selatan, 

Barat Daya, Barat, Barat Laut, Utara, Timur Laut, nah………… itulah sebabnya kenapa dalam proses 

pengambilan foto panorama kita perlu menggunakan kompas. Masih menggunakan GIMP, gambar 

yang telah dihilangkan tampilan langit tersebut, kita bagi menjadi delapan bagian yang sama. Kita 

dapat membaginya dengan sebuah skrip yang bernama Slice. Terlebih dahulu kita perlu membuat 

garis pandu (guide lines) yang nanti akan membantu pemotongan gambar, caranya kita tarik dari sisi 

kiri (penggaris pada tepi kiri jendela GIMP) dengan menggunakan tetikus, lalu arahkan ke titik-titik 

yang diinginkan.  Anda dapat mengubah ukuran gambar terlebih dahulu untuk memudahkan 

pembagian dan pembuatan garis pandu. Selanjutnya pilih menu Filters → Web → Slice, sehingga 

muncul jendela Slice, lalu isilah parameter di dalamnya sesuai dengan kebutuhan anda dan tekan 

tombol OK. 

 

Berikut adalah sedikit penjelasan mengenai parameter Slice yang patut kita ubah. 

Path for HTML export : isikan/pilih folder yang anda inginkan untuk menyimpan hasil pemotongan 

Image name prefix: isikan nama judul lanskap yang anda buat. Image format: pilih png untuk 

sekaligus mengekspor file gambar menjadi format .png. 

Separate image folder: pilih Yes untuk membuat flder baru tempat menyimpan potongan file 

panorama. 

Folder for image export: isikan judul folder baru, tempat menyimpan file potongan gambar 

panorama. 

Setelah membuat potongan gambar panorama maka anda telah membuat delapan file “side texture”. 

Sementara itu anda dapat membuat file “ground texture” dengan memotret tanah tempat berpijak anda 

di lokasi pengambilan gambar panorama, atau menggunakan pembesaran citra satelit pada lokasi 

pemotretan dengan Google Maps. Jangan lupa untuk menyimpan atau mengekspor gambar tersebut 

menjadi berekstensi .png. Anda dapat menggunakan aplikasi GIMP untuk mengedit dan 

mengekspornya. Letakkan gambar tersebut menjadi satu dengan delapan file “side texture” yang telah 

kita buat. 



 

Berikutnya kita membuat file konfigurasi lanskape dengan menyalin file landscape.ini dari salah satu 

lanscape yang ada di direktori /usr/share/stellarium/landscapes. Pada panduan ini kita gunakan file 

konfigurasi dari folder gueriens, karena sama-sama dibuat menggunakan metode Multi Image (old 

style). Kita salin file landscape.ini dari folder tersebut, lalu kita ubah beberapa parameter di dalam 

file sesuai kebutuhan kita. Berikut adalah sedikit penjelasan beberapa parameter dalam file 

landscape.ini (ubah yang dicetak miring dan berwarna) : 

[landscape]  

name = nama lanskap yang kita buat, diketik dalam lowercase 

author = nama kita selaku pembuat  

description = deskripsi / gambaran penjelasan mengenai lokasi lanskap 

type = old_style 

nbsidetex = 8 

tex0 = nama file “side texture” yang pertama.png #timur  

tex1 = nama file “side texture” yang kedua.png #tenggara  

tex2 = nama file “side texture” yang ketiga.png #selatan  

tex3 = nama file “side texture” yang keempat.png #baratdaya  

tex4 = nama file “side texture” yang kelima.png #barat  

tex5 = nama file “side texture” yang keenam.png #baratlaut  

tex6 = nama file “side texture” yang ketujuh.png #utara  

tex7 = nama file “side texture” yang kedelapan.png #timurlaut  

nbside = 8 

side0 = tex0:0:0.005:1:1 

side1 = tex1:0:0.005:1:1 

side2 = tex2:0:0.005:1:1 

side3 = tex3:0:0.005:1:1 



side4 = tex4:0:0.005:1:1 

side5 = tex5:0:0.005:1:1 

side6 = tex6:0:0.005:1:1 

side7 = tex7:0:0.005:1:1 

groundtex = nama file “ground texture”.png  

ground = groundtex:0:0:1:1 

fogtex = fog.png 

fog = fogtex:0:0:1:1 

nb_decor_repeat = 1 

decor_alt_angle = adalah ukuran sudut vertikal dari tekstur, yaitu seberapa tinggi mereka pergi ke 

langit (dalam angka) 

decor_angle_shift = sudut vertikal offset tekstur pemandangan, di mana ketinggian adalah tekstur 

sisi ditempatkan (dalam angka) 

decor_angle_rotatez = rotasi sudut pemandangan di sekitar sumbu vertikal. ini adalah berguna untuk 

memutar lanskap jadi Utara pada arah yang benar (dalam angka) 

ground_angle_shift = sudut vertikal offset tekstur tanah, di mana ketinggian  

tekstur tanah ditempatkan. 

ground_angle_rotatez = rotasi sudut tekstur tanah di sekitar sumbu vertikal.  

Ketika sisi diputar, tekstur tanah mungkin perlu diputar juga untuk menyesuaikan dengan sisi (dalam 

angka) 

fog_alt_angle = 20 

fog_angle_shift = -3 

draw_ground_first = 1 

[location]  

planet = Earth 

latitude = koordinat lintang dari lokasi lanskap (ikuti format dalam file asli) 

longitude = koordinat bujur dari lokasi lanskap (ikuti format dalam file asli) 

altitude = ketinggian lanskap (angka dalam mdpl) 



 

Setelah mengedit, kita simpan dan jadikan satu folder dengan sembilan file gambar “side texture” dan 

“ground texture”. 

Setelah semua file lanskape jadi, kita tinggal menyalin folder dan isi lanskap ke direktori sistem dari 

Stellarium. Terlebih dahulu kita buat  folder baru pada direktori sistem Stellarium. 

Gunakan aplikasi terminal, lalu ketikkan sudo mkdir /usr/share/stellarium/landscapes/(nama 

folder lanskap kita) 

Selanjutnya tinggal kita salin isi folder lanskap buatan kita ke direktori baru yang telah kita buka. 

Aktifkan direktori folder lanscape dengan mengetik cd ~/folder lanskap  

lalu ketik cp *.* /usr/share/stellarium/landscapes/(nama folder lanskap kita) 

Apabila seluruh proses berjalan dengan baik, kita bisa melihat hasil lanskap buatan kita 

terpasang  pada aplikasi Stellarium, dengan membuka jendela View (tekan tombol F4) pada tabulasi 

menu Lanscape. 

 

Demikian panduan membuat lanskape pribadi pada Stellarium. Anda dapat mencoba karya iseng saya 

dengan mengunduh lanskap Tinjomoyo disini. Lalu salin dan ekstrak pada direktori 

/usr/share/stellarium/landscapes. Semoga bermanfaat dan menyenangkan kegiatan ber-stellarium  

  

https://www.dropbox.com/s/w3hibdjqx0ddn5g/tinjomoyo.zip?dl=0


Membuat Gambar Panorama dengan GIMP dan Pandora 

 

Gambaran pemandangan keindahan alam seringkali memukau untuk kita simak. Namun adakalanya 

kita tidak memiliki peralatan yang cukup canggih untuk mengabadikannya. Tetapi anda jangan 

khawatir, karena kita bisa memanfaatkan kamera saku kita untuk membuat sebuah gambar panorama 

(pemandangan) menggunakan GIMP dan Pandora. GIMP merupakan aplikasi penyuntung gambar 

yang amat populer di dunia opensource. GIMP digadang sebagai alternatif dan subtitusi bagi aplikasi 

penyunting gambar berbayar seperti Photoshop. Aplikasi GIMP umumnya sudah terinstall dalam 

berbagai distro Linux, khususnya BlankOn Linux. Sedangkan Pandora merupakan sebuah skrip yang 

digunakan untuk membuat gambar panorama. Pandora dibuat oleh Akkana Peck, anda dapat 

mengunjungi web Pandora di http://www.shallowsky.com/software/pandora/ atau menghubungi 

pembuatnya melalui surel di akkana@shallowsky.com. 

Teknik merangkai foto-foto pemandangan untuk membuat sebuah gambar panorama dikenal dengan 

istilah Stiching. Kita bisa melakukannya secara manual yaitu dengan membuat banyak masking, 

mengatur ukuran kanvas, dll. Namun langkah tersebut akan memakan waktu yang cukup lama, 

terutama buat pemula di GIMP seperti saya, hehe :D. Alih-alih menghabiskan banyak waktu untuk 

merangkai dan menyunting foto-foto pemandangan, kita dapat menggunakan fitur dari Pandora untuk 

mempermudah perkerjaan kita dalam membuat sebuah foto panorama. Dalam panduan ini, kita akan 

memanfaatkan GIMP dan Pandora untuk membuat gambar panorama. Kita dapat memanfaatkan 

hasilnya untuk berbagai keperluan, di antaranya untuk membuat lanskap pribadi dalam aplikasi 

Stellarium (lihat panduan Stellarium #9). 

Mengambil Foto Panorama 

Untuk mengambil foto panorama kita dapat memakai kamera saku biasa, akan tetapi terdapat 

beberapa hal yang harus kita perhatikan dalam pengambilan. 

Pertama, kita harus memastikan ketinggian kamera tetap/tidak berubah-ubah saat proses 

pengambilan foto. Dengan menggunakan dudukan yang tetap seperti batu, tembok, atau tripod akan 

sangat membantu dalam menetapkan posisi kamera. 

Kedua, usahakan seting ukuran foto pada kamera diatur menggunakan rasio minimal 4:3. Rasio ini 

menunjukkan hasil yang cukup baik. 

Ketiga, ketika berputar mengubah posisi saat mengambil gambar yang baru, usahakan tidak melebihi 

sudut 45°. Semakin kecil sudutnya dan semakin banyak kita mengambil foto-foto yang berurutan, 

akan memberikan hasil yang semakin bagus. 

Keempat, lakukan pengambilan gambar secara berurutan, entah anda berputar searah jarum jam atau 

berlawanan arah jarum jam. Hal ini akan mempermudah anda dalam menyunting foto-foto menjadi 

gambar panorama. 

Kelima, lalukan pengambilan gambar di saat dan waktu yang tepat. Karena kita tidak melakukan 

pengambilan foto di sebuah studio, maka kita harus memperhatikan cahaya, cuaca, dan berbagai hal 

lainnya yang dapat mendukung atau menghalangi proses pemotretan. Saya sarankan untuk 

mengambil gambar di pagi (antara pukul 6.00-9.30) atau sore (antara pukul 15.30-16.30) hari, kecuali 

jika anda memiliki tujuan tertentu, misalnya memotret peristiwa Sunrise atau Sunset. 

Membuat Gambar Panorama dengan GIMP dan Pandora 

http://www.shallowsky.com/software/pandora/
http://panduan.blankonlinux.or.id/pendidikan/membuat-lanskap-panorama-pribadi-pada-stellarium/


Setelah meastikan GIMP terpasang dengan baik dalam operasi anda, selanjutnya kita unduh dulu skrip 

Pandora. Anda bisa mengunduhnya di http://www.shallowsky.com/software/pandora/pandora-

combine-0.9.3.scm . 

Selanjutnya kita pasang skrip Pandora di direktori skrip pada aplikasi GIMP. Anda tinggal menyalin 

nya pada direktori pengguna di ~/.gimp(versi)/scripts, atau pada direktori sistem di 

/usr/share/gimp/2.0/scripts. Jika Pandora berhasil terpasang, akan muncul opsi Arrange as 

Panorama pada menu Filters → Combine. 

Bukalah program GIMP. Pada BlankON aplikasi GIMP dapat ditemukan pada menu Applications → 

Graphic Editor → GIMP. 

Setelah aplikasi GIMP terbuka, kita buka file-file foto pemandangan yang telah kita ambil. Bukalah 

file-file tersebut secara berurutan dalam layer-layer. Kita bisa melakukannya dengan membuka menu 

File → Open as Layers, setelah terbuka jendela Open Image lalu kita pilih file-file foto. Gunakan 

tombol Ctrl atauShift untuk memilih rangkaian file. Kemudian tekan tombol Open pada bagian 

kanan bawah. 

Setelah itu file-file foto akan terbuka dalam susunan layer . Anda dapat menekan tombol Ctrl+L 

untuk memunculkan jendela Layers. 

 

Berikutnya kita akan mulai memanfaatkan fitur dari Pandora untuk membuat gambar panorama. Pilih 

menu Filters → Combine → Arrange as Panorama. Setelah itu akan muncul jendela Script-Fu: 

Arrange as Panorama. Kita hanya perlu mengubah parameter presentase overlap sesuai keinginan 

kita. Nilai default yaitu 50, biasanya memberikan hasil yang cukup memadai. Kemudian kita tekan 

tombol OK. Maka…… wush……. seketika rangkaian foto kita akan tersusun sebagai sebuah 

gambaran panorama hehe. Eits tapi jangan senang dulu, pekerjaan kita belum selesai, karena kita 

harus mengatur gambar-gambar dalam tiap layer untuk memperbagus hasilnya. 

 

Mula-mula kita gunakan Move Tool, kita tekan tombol M untuk mengaktifkannya. Kita atur kembali 

posisi dari tiap-tiap gambar di mulai dari layer paling bawah (gambar paling kiri). Aktifkan layer 

paling bawah dengan mengllik pada layer paling bawah di jendela Layers, pastikan layer tersebut 

aktif dengan adanya oultine(garis tepi) putih pada layer yang kita pilih. Lalu dengan menggunakan 

Move Tool kita selaraskan rangkaian gambar dari layer paling bawah hingga paling atas. Jangan lupa 

untuk menggunakan fitur penguncian layer (klik tanda rantai di sebelah tanda mata pada jendela 

http://www.shallowsky.com/software/pandora/pandora-combine-0.9.3.scm
http://www.shallowsky.com/software/pandora/pandora-combine-0.9.3.scm


Layers) setelah menyelaraskan suatu layer, supaya kita tidak dipusingkan dengan pengaturan kembali 

layer yang tidak sengaja tergeser. 

 

Setelah gambar dirasa cukup selaras, anda dapat memanfaatkan tool-tool yang lain seperti Clone Tool 

(tekan tombol C) dan Healing Tool (tekan tombolH) untuk memperbagus hasil akhirnya. Anda juga 

dapat mengaplikasikan berbagai tool dan teknik penyuntingan gambar yang lainnya semisal masking, 

transform, melakukan crop, menghiasnya dengan bingkai, atau memberi efek gambar sesuai dengan 

imajinasi dan kreativitas anda. 

Setelah selesai membuat gambar panorama anda bisa menyimpannya dengan Save menekan tombol 

Ctrl+S, atau mengexportnya kedalam format file yang lain dengan Save As menekan tombol 

Ctrl+Shift+S atau pilih menu File → Export as. 

————————————————————————————————————————

—————————————————————————————- 

*Tambahan Informasi: Seputar Fitur Default dari Menu Filters → Combine 

Selain Arrange as Panorama sebagai fitur dari Pandora, menu Filters → Combine juga memiliki dua 

fitur lain sebagai fitur asli. 

Fitur Deep Merge digunakan untuk mengkombinasikan dua buah gambar dengan pengaturan yang 

lebih kompleks. Fitur ini bisa anda gunakan untuk membantu mengkombinasikan dan menyunting 

dua buah gambar pembentuk panorama, sehingga dapat diaplikasikan untuk memperbaiki hasil 

pembentukan gambar panorama dari Pandora. Anda dapat menggunakannya dengan memilih menu 

Filters → Combine → Deep Merge. Lalu anda pilih dua file gambar yang anda inginkan (terlebih 

dulu gambarnya di buka dalam layer yang berbeda, lihatOpen as Layers), selebihnya anda atur 

parameter-parameter yang ada lalu tekan tombol OK. 

 

Fitur Filmstrip digunakan untuk membuat susunan strip film berdasarkan gambar yang telah dibuka 

dalam susunan layer. Kendati tidak berhubungan secara fungsional dalam membuat suatu gambar 



panorama, toh anda masih bisa bersenang-senang dengan skrip ini. Pilih menu Filters → Combine 

→ Filmstriphingga muncul jendela Filmstrips. Lalu anda atur berbagai parameter yang ada sesuai 

keinginan anda dan tekan tombol OK, maka seketika akan muncul jendela GIMP yang baru 

menampakkan hasil pembuatan strip film. 

 

————————————————————————————————————————

————————————————————————————– 

Demikian panduan membuat gambar panorama dengan GIMP dan Pandora. Semoga bermanfaat. Oh 

ya, berikut adalah salah satu contoh karya iseng saya hehe, gambar panorama di jembatan ex-kebun 

binatang Tinjomoyo Semarang, please enjoy  

 

 


